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1.  FITCHRATINGS DATA FORMATS 

1.1. Input into Raw Data Models 

FITCHRATINGS inputs the financial data, usually from a bank’s annual report, 
into “models” that are specific to each country.  Each model, identified by a nickname 
(see Help, Format Definitions), is made up of a sequence of lines following the bank 
annual report: balance sheet, profit and loss, off-balance sheet items and notes. 
Alterations to the data as provided by the bank are minimal. 

This input model, or template, is called the Raw Data format. This format can be 
viewed in English, and often in the native language as well 1. 

Some countries2 have more than one raw data model, where there is a group of 
banks with different reporting practices (e.g. Japanese securities houses or U.S. bank 
holding companies).  From time to time the lines of a model may be amended to reflect 
changes in a country’s accounting reporting regulations. 

We feel that our country-specific input technique is the most efficient way to 
reflect the diversity of accounting practices worldwide, and to accommodate the trend 
towards increasingly detailed reporting requirements. 

 

1.2. Spreadsheet Format 

The Spreadsheet format is derived from the Raw Data.  While spreadsheets for 
all the banks share a similar structure, components of the standard sections may vary 
from one country to the next, depending on that country’s reporting requirements.  

 

For example, the Liabilities side always contains the following sections: 
Customer and short term funding; Other Funding; Other (non-interest bearing); Loan 
Loss Reserves (not deducted from Assets) and Equity.  However, Other Funding might 
contain Long term Borrowing, Subordinated Debt, Participating Debt or Hybrid 
Capital.  Similarly, the ratios associated with the spreadsheet are country-specific.  

Definitions of each country’s spreadsheet components may be found under  
Help, Format Definitions. 

                                                 
1
 Multiple formats:for: Danish, French, German, Italian, Japanese, Norwegian, Portuguese, Spanish & Swedish 

2
 Native language for: Belgium, Canada, France, Ireland, Japan, United Kingdom and United States 
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1.3. Global Summary and Detailed Formats 

The two Global formats are globally standardised presentations derived from the 
country-specific spreadsheet and raw data items. All bank reports in BankScope may be 
viewed in these formats, which have been designed to allow easy comparison of banks 
worldwide:  

 

?? The Global Summary format contains 37 lines (including two capital 
adequacy ratios and seven memo lines).  This format also includes thirty-six 
standard ratios. 

 

?? The Global Detailed format contains 156 lines (51 lines for the Assets, 42 
lines for the Liabilities and Equity, 38 lines for the Income Statement and 15 
lines of Notes). 

 

Definitions of the Global formats components may be found under Help, Ratio 
Definitions.  Alternatively, clicking on the triangles to the left of a global line item will 
create a drop-down of that item’s more detailed data components. 

 

1.4. Profile 

The Profile format provides standardised financial highlights, showing four lines 
of accounts (Assets, Customer and Short Term Funding, Equity and Net Income) and 
eleven ratios. 
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2.  BANKSCOPE MAIN SCREEN 

 BankScope’s main menu is permanently fixed on a button bar across the top of 
the initial screen.  Most of BankScope’s functions are accessed through the button bar 
(Figure 1), and you may move continually through the buttons, selecting new functions 
or refining a search, without having to “back out” of any particular screen. 

  

 prints what is currently displayed on the screen 

 

 exports what is currently displayed on the screen 

 

 access to the various search criteria  (see Chapter 6) 

 

 displays the list of selected banks (see Chapter 5) 

 

 displays the reports of selected banks or the first report selected 
(see Chapter 4) 

 

 displays the selected banks in the Bank Credit Report (BCR) 
presentation software (see Chapter 12). This is an optional module 
on BankScope 

 

 compares one or more banks with the mean and the average of a 
group of banks 

 

 starts a statistical analysis of a group of banks 

 

 This “dustbin” icon clears the screen and brings you back to the 
main menu 

 

For information on the File and Options menus, see Chapter 15. 



 

 

 

 

 

 

 

 

 

 

 
Figure 2 



SEARCHING BY BANK NAME 

 3 - 1  

3.  SEARCHING BY BANK NAME 

 Click on the   button. The yellow buttons below the main button bar 
offer you several search criteria. In this chapter, we will deal with the Bank Name 
criterion. For more information on the other yellow search buttons, please refer to 
Chapter 6. 

Click the  button. 

The alphabetical index of banks (the Name index) appears on the screen (Figure 2). 
Type in the first letters of the bank name (acronyms and native language can also be 
used). The search will continue until you have typed enough of the string to locate the 
bank you want.   

To facilitate your search, major banks3 are displayed in red in the list. You may 
verify your selection by highlighting the bank and checking the “snapshot” which 
appears within the search box, displaying the banks’ country, specialisation, ratings and 
four financial values. 

Select the bank by double-clicking it, or by clicking . The name of the bank is 
displayed in the Records Selected window. To deselect banks from the Records Selected 
window, click . Clicking  will remove all banks from that window. 

The identifying columns to the right of the bank names indicate: consolidation 
(1st column); country (2nd column); format (3rd column); presence of Reuters 
News (4th column); presence of Ownership information (5th column); presence of 
interim data (6th column) (Figure 2). 

You will find hereafter a list of the used abbreviations. 

                                                 
3   Major Banks are defined as being rated by one of the five rating agencies on the BankScope product, namely 

Fitchratings, Moody's, Standard & Poors, Thomson BankWatch or Capital Intelligence. The list was filtered to 
eradicate duplications and now contains 1400 major banks. 
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a) Consolidation code 

 
NA : Bank with no statement. Only the name and address are available 

C2 : Consolidated Statement with an Unconsolidated Companion 

C1 : Consolidated Statement with no Unconsolidated Companion 

C* : Additional Consolidated Statement from a different source 

U2 : Unconsolidated Statement with a Consolidated Companion 

U1 : Unconsolidated Statement with no Consolidated Companion 

U* : Additional Unconsolidated Statement fro m a different source 

A2 : Aggregated Statement with one Companion 

A1 : Aggregated Statement with no Companion 

 

b) Country codes 

They are the ISO codes (e.g. US for the United States) corresponding to the country 
of the bank. 

 

c) Format codes  

Indicate the type of data available for a bank (usually RD). 

 

RD: statement available in the raw data format 

RF: statement under processing by FITCHRATINGS 

VD: statement available in global format only 

DD: no longer existing bank 

BR: branch with no statement 

NA: banks with no statement: only the name and address are available. They are mainly E.U. 
banks listed in the Official Journal. 

 

d) Reuters News and Ownership (“R” & “O” in the 4th and 5th columns) 

They are optional modules which provide two years of Reuters News stories, and 
listings of a bank’s shareholders and subsidiaries. 

 

e) Interim data (“I” in the 6th column) 

This type of data is available for 3,500 institutions. 
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3.1. Truncation 

Clicking on  followed by a click on  selects all banks starting with the 
string that you have typed in. 

3.2.  Standard Peer Group 

Clicking on  displays the list of 
banks belonging to the Standard Peer Group of the highlighted bank. Standard Peer 
Groups have been pre-calculated on the disk. The Standard Peer Group is made up of 
all banks that have been input in the same FITCHRATINGS model.  



 

 

 
Figure 3 

 

Figure 4 
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4.  THE BANK REPORTS 

In this chapter, we will review the various types of bank reports as well as their  
associated graphs. In BankScope, a “Report” is defined as a financial statement either 
alone or combined with any other information available for a bank (ratings, address,  
Reuters News etc).  

4.1. The Report Screen 

A report may be accessed in several ways: 

?? by performing a search by name 

?? by double-clicking on a bank in a list of selected banks 

?? by clicking on the Report button at the top of the screen  

 

Two examples of Reports may be seen in Figure 2 and in Figure 4. 

 

At the bottom of the report screen, you will find a toolbar showing 10 buttons 
and 8 icons described hereafter. 

 

 allows you to go to the first, previous, next and last 
selected statement. If you want to go to a specific 
statement, type its number in the white area and press 
enter 

 displays the list of selected banks 

 “marks” a report; the “marked” report can be printed, 
transferred or deleted from the current selection (or, 
conversely, the unmarked reports) 

 allows you to view other available statements 
(consolidated, unconsolidated or additional 
companions) for the same legal entity 

 displays a menu enabling you to display a specific 
section of the report, to create new formats (i.e. to 
create a set of sections that should be displayed) or to 
display the reports in one of the FITCHRATINGS 
standard formats: Raw data, Spreadsheet, Global 
detailed, Global Summary or Profile (see section 4.2) 



 

 

 
 
 
 
 
 
 
 

 
Figure 5 

 
 
 
 
 
 
 
 

 
Figure 6
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 displays a menu to define a new “presentation” of 
columns (in terms of nature and order of presentation of 
numerical data) or to display statements in a pre-
defined layout (see section 4.3). 

 displays - in brackets - the relative position of the bank 
within the quartiles or the deciles of the Standard Peer 
Group or the Current Own Peer Group which has been 
assigned to the displayed bank (see the PG button 
below). 

 allows users to type in comments related to the 
displayed bank.  

 displays a menu that allows you to associate an Own 
Peer Group to the bank and to view the list of banks 
belonging to that peer group (see Figure 5) : 

 View the current PG: allows you to view the number of 
banks belonging to the Current Own Peer Group of the 
selected bank and to display a list of them. 

 Compare the company to another PG already 
associated with it: allows you to select one of the 
associated Own Peer Group to which you want to 
compare the selected bank. 

 Associate a new PG to this company: displays a dialog 
box (see Figure 6) in which you can select a bank and 
assign to it a previously saved Own Peer Group (see  
section 9.8). To define a link, select both the bank and 
the own peer group, then click the “Associate” button. 
The check box next to the bank name will be ticked. 

 goes back to the report when a graphical illustration is 
displayed. 



 

 

 

 
Figure 7 

 
Figure 8 
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Height graphical illustrations are associated with a bank report. To display those 
illustrations4, simply click the following icons: 

 

 displays the illustration of the Balance Sheet (see Figure 7) along with two 
structure ratios (the Total Capital Ratio and Liquid assets / Cust & ST 
Funding) which are compared to the median of the Standard Peer Group (or 
the Current Own Peer Group if there is one associated to the bank displayed). 
The figure between brackets next to “Peer Group” indicates the number of 
banks of the peer group for which a value of this ratio is available. By 

clicking the arrows of the button , you will display the same 
illustration for the previous or the following years.  

 

 

 

 displays the illustration of the Income Statement (see Figure 8) along with 
two ratios (Return on Average Assets and Return on Average Equity). Both 
are once again compared to the median of the Standard Peer Group or the 
Current Own Peer Group (see previous paragraph). 

 

 

 

 

 

 

 

 Displays a bar chart for one variable (see Figure 9). The illustrated variable 
is selected by using the two menus above the bar chart. The  button 
allows you to modify the period displayed. 

 

                                                 
4
 These can be copied and pasted into Excel or Word. 



 

 

  

  
Figure 10 

 

 
Figure 11 

 

Figure 12 
 
 

 
Figure 13 

 
Figure 14 
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 displays the illustration of several variables in indices (Figure 10). Note 
that: 

 

?? the diagram is presented, by default with a set of five “standard” 
variables. By clicking on the  button, a new set of variables 
can be created or a former set can be selected. [This is also possible 
via the “Options” menu. See Chapter 15]. You can also define any 
selection of variables as “current” set, which will be displayed by 
default; 

?? you can change the year base (for which the variables are 
considered as indice 100%), by clicking on the menu on the right-
hand side at the bottom of the screen. The figures displayed in the 
top window indicate the values taken by the variables for the year 
base selected. 

 displays the illustration of the evolution of a set of variables in the 
deciles of the peer group (see Figure 11) : this graph can be displayed 
for the same set of variables as those used for the graph in indices 
(Figure 10). It is an interesting complement to the latter: the graph in 
indices shows the evolution of the selected variables compared to the 
values taken for a reference year. The second graph (Figure 11) shows 
the same evolution, but compared to the deciles of the standard peer 
group. Therefore, a variable can increase in the first graph but remain 
steady in the second, meaning that in relative terms, the variable has 
undergone the same growth for the bank as for its standard peer group. 
If the growth for the standard peer group is greater, the variable will 
increase in the first graph and decrease in the second. 

 

 displays the graphical illustration of the shareholders and the 
subsidiaries (see Figure 13). This illustration can be extended or 
reduced by clicking on  in the tree. Clicking on  will 
display the snapshot of the bank in the box and  will display 
relevant information concerning the changes in shareholders and 
subsidiaries issued in recent press releases. Note that the layout of the 
illustration can be customised by clicking on the  button (see 
Figure 14). 

?? the number of levels displayed vertically as well as the number of 
banks per level can be freely specified; 

?? the information to be included in the boxes can be selected as well 
as the fonts to be used;  

?? the number of pages on which the resulting tree will be printed 
can be set by the user. 



 

 

 

 

 

 

 
Figure 15 
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 displays the illustration of the past evolution of the ratings 
(Figure 15). The illustrated rating is selected by using two menus 
on top of the bar chart window. 

 this icon is an optional module that start your browser and gives 
an on- line access to the scanned annual reports available on the 
Bureau van Dijk’s website in Adobe Acrobat Format. For the  
Annual Reports containing more than 25 pages, you can access  
any of the 12 following specific sections : 

 
 - Letter of the Chairman; 

 - Financial Highlights; 

 - Consolidated Accounts; 

 - Notes to the Consolidated Accounts; 

 - Report of the Auditors (Consolidated);  

 - Unconsolidated Accounts; 

 - Note to the Unconsolidated Accounts; 

 - Report of the Auditors (Unconsolidated);  

 - Ownership; 

 - Subsidiaries and Branches; 

 - Management Report/Business Review; 

 - Board of Management/Directors/Managers. 

 

 



 

 

 

 

Figure 16 

 

 

 

Figure 17 
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Here are some explanations concerning the structure of a report (Format) and the 
way columns are presented (Layout). 

4.2. The Format button 

The Format button displays a list of those formats already available in 
BankScope.  You may select them as required from this list, or create a new report 
which incorporates several sections from the format list.  For example, you may select 
the Header followed by the Ratings section and the Spreadsheet as your custom report 
format. 

The “Complete Format” presents all the available sections in the following 
order: 

?? Header 
?? Rating 
?? Profile 
?? Global Summary 
?? Standard Ratios 
?? Spreadsheet 
?? Raw Data 
?? Banking Subsidiaries 
?? Shareholders 
?? Reuters News 
?? Note 
 

In addition to these sections, you may create your own “Customised Format” or custom 
spreadsheet from any part of these formats (see Chapter 7), and your own custom ratios 
(see Chapter 8), both of which can be incorporated into your Report. 

 

 You can create as many custom combinations of the above formats as you like.  
Click on ,  then on New Report Format (Figure 17).  Name the format, select the 
sections you want (and check the box “Keep this format as your current format” if you 
want to establish that format as your default).  

 The “Standard” format (which is presented by default) is made up of the 
following sections: Header, Rating, Global, Standard Ratios, Spreadsheet, Banking 
Subsidiaries, Shareholders and Reuters News. 

When either the “Global - Summary” or the “Global - Detailed” format is 
displayed, clicking on  in front of any line, breaks the line item into its more detailed 
components. For instance, if you click on the “Loans” line of the “Global – Summary 
Format”, you will display the various lines corresponding to the associated 
“Spreadsheet Format” (Figure 16). If you now click on any of these lines, you will see 
the breakdown of the spreadsheet item into the lines of the “Raw Data Format”.  

To view the line numbers, choose Report-Show Account numbers from the menu 
bar. 

A printed or transferred presentation will retain the opened items. 



 

 

 
Figure 18 

 
Figure 19 
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Displaying the Shareholders information (or Banking Subsidiaries) section will 
present the list of shareholders (or subsidiaries) sorted by percentage of interest (Figure 
18 and Figure 19). Several codes indicate the information source in the fifth column of 
this section :  

 

RM  annual Report of the mother company. 

 

RS  annual Report of the Subsidiary. 

 

PC  direct contacts with the concerned institutions (twice a year a 
mailing is sent to all banks hosted on BankScope) 

 

PN information published in the press; an analyst located in Brussels 
is exclusively devoted to the task of analysing the news on 
ownership that is published in the daily or periodical financial 
press. An average of about 5 news articles related to 
modifications in the ownership of banks is published per day. 

 

OS information collected from other published sources (with 
authorisation by the information providers concerned). 

 

TC telephone calls made by an independent research company to 
follow up some institutions. 

 

VD information collected from the other databases distributed by 
Bureau van Dijk. 

 

 Some of the banks listed have their total assets indicated for the last available 
year and are displayed in bold and underlined. A click on one of these banks will bring 
you to its report, allowing you to navigate within the shareholders and subsidiaries 
database. A click on the  button will bring you back to the first bank selected. 

 



 

 

 

 

 

 

 

 

 
Figure 20 
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4.3. The Layout button 

In BankScope the term Layout refers to the column structure. Editing the column 
layout using the Layout button allows you to: 

 

?? determine currencies of data 

 

?? apply exchange rates 

 

?? show year-to-year variation or relative size 

 

?? view interim or year end data 

 
These types of figures are available for individual banks or Peer Groups (Median 

or Averages). 
 
The standard layout presents the annual accounts in local currency for all the 

years available with the most recent year to the left.  
 
You can create as many layouts as you wish. To create a layout, click the  

button. The list of existing layouts appears, the current layout is marked with a ? .  The 
item “New layout” comes first on the list. If you click on it, a dialog box will appear 
(Figure 20) which enables you to customize the columns of your speadsheet. Select first 
the type of figures, then the year and finally click on .  By selecting Last Interim, 
Interim -1, etc.. in the year box, Interim figures will be displayed when available. 

 

 To create a spreadsheet entirely in $US, select “New Layout” and name the 
layout USD.  Check the radio button Money values in a reference currency (Nominal 
Value), enter USD in the ISO code box, select Last Year through Year-7 by highlighting 
those years and clicking on .  Click .  This column layout will now be shown 
(as USD) on your Layout menu for use with any bank.  More than one currency may be 
combined in a spreadsheet using this principle. 

 If the radio-button Money values in a reference currency (Inflation Adjusted) is 
selected, all financials of that column will be recalculated in order to get rid of the 
inflation effect and to present the accounts in real terms. Financials will be presented at 
the money value of the last available year, the Consumer Price Index coming from the 
IMF being used to adjust the published figures. 
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 When a variation is chosen, the year given is the reference year. For example, 
the combination variation / year 1 (the most recent year) gives the increase in 
percentage between year 1 and year 2. Money values can be presented either in original 
currency or in one or several reference currencies. Variations can be calculated based on 
the values in original currency or in reference currency. 

 

By clicking on the “Own rates” radio-button, the exchange rates defined by the 
user will be used (see section 15.1 explaining how to input your own exchange rates). A 
click on “Market Rates (Current)” will use the official rates (as published by the 
International Monetary Fund) at the corresponding closing date of the bank displayed. 
Clicking on “Market Rates (Last reported date)” will use the exchange rate at the last 
closing date for all preceding years displayed. 

 
Clicking on the “Peer (Medians)” or “Peer (Averages)” radio-buttons will 

display the data corresponding to the “Standard Peer Group” of the bank selected (or 
the Current Own Peer Group associated by the user, if any) instead of the subject bank.  

 

If the ‘Relative’ radio button is checked, the most recent available year will 
always be displayed in the left column. On the contrary, if the ‘Absolute’ radio button is 
checked, you can select several years in "absolute" reference: if the data for that year is 
not available, no value will be displayed in that specific column. 

 

 By clicking on the check box “Keep this layout as your current format”, your 
new layout will be substituted for the current layout. 

 

 It is also possible to create new layouts by clicking on the option “Layout” from 
the menu “Options” at the top of the screen (see Chapter 15). 

 

 Concerning the relative sizes, for the income statement the line ‘Operating 
Income (Memo)’ of the Global Format represents the base of 100 %. For the balance 
sheet, the denominator is, of course, Total Assets. 

 

 



 

 

Figure 21 

 

Figure 22 
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5.  BUILDING A LIST OF BANKS 

 

The “List” of the selected statements will be displayed: 

 

- automatically if several banks have been selected from the Name index, by 
Swift number, index number or nickname; 

 

- by clicking on the  button if the selection is the result of a multi-
criteria search or of a saved bank set or search strategy. 

 

An example of such a list is illustrated in Figure 21. 

5.1. Format of a list 

 

The standard format of a list - which is displayed by default - includes the 
following fields: consolidation code, sorting variable, last available year, country code, 
country rank rolling, world rank rolling, index number 

 

In order to create a new list, click on the  button. This will unfold a menu 
presenting all the formats already designed as well as a line “New Format”. A click on 
this line will display a dialog box (see Figure 22) enabling you to select the items to be 
included in a list format.  

 

[It is also possible to create new list formats by clicking on the option “Format 
of List” from the menu “Options” at the top of the screen (see Chapter 15).] 

 

Note that the width of a column can be modified by dragging the top of the 
border between two columns. This will be saved along with the format. 



 

 

 

 
Figure 23 

 
 
 

 
Figure 24 
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5.2. Sorting a list 

 

All lists are sorted by default according to Total Assets for the last available year 
in descending sequence. 

 

However, you can instantly change the sorting key by clicking on the  
button which displays a dialog box (Figure 23) showing the available sorting variables. 
Select your sorting variable and click on . The list is immediately reorganised 
and sorted according to the selected variable (in descending or ascending sequence, as 
you have specified).  

 

[It is also possible to change the default sort by clicking on the option “Default 
sort” from the menu “Options” at the top of the screen (see Chapter 15).] 

 

5.3. Marking and deleting Banks from a list 

 

A click at the left of any line will “mark” the statement. 

 

Any “marked” or “unmarked” statements of the list can be deleted by clicking on the 
 button. 

 

Note that you can choose to display, print or transfer only the marked - or unmarked - 
statements. 

5.4. Associating a peer group to a bank 

The  button allows you to display a dialog box (Figure 24) 
allowing you to associate an existing own peer group with each of the banks listed. For 
more details on the use of own peer groups, please refer to section 6.7. 
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6.  MULTI-CRITERIA SEARCH 

 It is possible to search for one or several banks by name (see Chapter 3). It is 
also possible to search for one or several banks by their Swift numbers, their Nicknames 
or their Index Numbers. 

 

 Finally, it is possible to select a group of banks by combining some or all of the 
following criteria: 

 

 - geographic location; 

 - specialisation; 

 - large banks; 

 - financial data; 

 - ratings; 

 - affiliations; 

 - updated statements; 

 - miscellaneous (see section L). 

 

These criteria can be combined by using “and” operators (which are used by default) or 
by using any other combination of the Boolean operators “or”, “and” and “and not” 
(see section 6.4 hereafter). 

6.1. Description of the Criteria Available 

 The different criteria can be accessed by fourteen buttons that appear at the top 
of the screen when clicking on . 

 

 
 

6.1.1. SEARCHING BY BANK NAME 

 

The search by Bank name has been described in Chapter 3. 
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6.1.2. SEARCHING BY NICKNAME 

Every type of statement is identified by a “nickname”, which is a string of up to 
8 characters.  

Click  to display a dialog box with the index of available 
nicknames. Type the first characters of the nickname searched for and the index will 
automatically highlight the first nickname of the index starting with that string. The 
corresponding snapshot will also appear in the top right-hand corner of the window. 
Click on  to select the highlighted line and  to validate the selection.  

  

6.1.3.SEARCHING BY INDEX NUMBER AND SWIFT NUMBER 

Click on  to start the search. A drop-down list will appear 
allowing you to select an Index number or Swift number:  

 

?? In the case of search by Index number, several index numbers can be 
entered successively. When this is done, click on . If only one 
index number has been entered, the report will be directly displayed, if not, 
the list of selected banks will be displayed. 

 

?? In the case of a search by Swift number, a dialog box shows the Swift 
numbers index. Just type the Swift number and the index will highlight the 
line starting with this string. Click on  to validate the selection. 

6.1.4. SEARCHING BY  GEOGRAPHIC AREA  

 

Click on  to start the search. A yellow menu appears enabling 
you to choose between a search by country or by world regions. 

 

?? In the case of a search by country, a dialog box presents the index of 
countries. Just type in the first characters of the country’s name and the 
index will highlight the line starting with this string. Click on  to select 
the line and on  to validate the search. 

 

?? In the case of a search by world regions, a dialog box displays a list of 
world regions. Just click on the regions you are looking for. Click on  
to select the region(s) and  to validate the search. 
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6.1.5.SEARCHING BY SPECIALISATION 

Two types of specialisations are available in BankScope: the general 
specialisation and the country specific specialisation.  

 

A general specialisation code has been assigned to each bank based on the 
annual report. These codes have been grouped into 12 categories defined as follows: 

 

??  Commercial Banks 

??  Savings Banks 

??  Co-operative Banks 

??  Real Estate/Mortgage Banks 

??  Medium and Long Term Credit Banks 

??  Investment Banks/Securities Houses 

??  Islamic Banks 

??  Non Banking Credit Institutions 

??  Specialised Governmental Credit Institutions 

??  Bank Holdings and Holding Companies 

??  Central Banks 

??  Multi- lateral Governmental Banks 

 

The country specific specialisations are available for the 15 EU countries as well 
as for Switzerland and Japan. For banks of the EU and the EFTA countries, the Official 
Journal of the EU supplies a classification of the listed banks according to their 
specialisation. These categories vary from one country to another since they are based 
on the declarations made to the European Commission by the relevant professional 
organisation of the member states. For Swiss banks, the classification is given by the 
Commission Fédérale des Banques. For Japanese banks, it is supplied by the Federation 
of Bankers’ Associations of Japan (Zenginkyo) . 

 

Click on . A dialog box showing the general specialisation is 
displayed by default. Select the line corresponding to the needed specialisation and click 

 and  to validate the search. 



 

 

 

 

 

 
Figure 25 

 

 

 
Figure 26 
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In order to select a country specific specialisation, select one of the EU 
countries, Japan or Switzerland (see section 6.1.4) first, then click . 
The different country specific specialisations (see Figure 25) will appear in the list. 
Highlight the desired specialisations and click  to select them. Click  to 
validate the search. It is still possible to use the general specialisation by checking the 
general radio button.  

 

6.1.6.SEARCHING BY LARGE BANKS 

 

Clicking  automatically selects all banks with Total Assets 
greater than one billion USD for the last available year. 

 

6.1.7.SEARCHING BY FINANCIAL DATA 

 

It is possible in BankScope to make a search based on the figures related to: 

 

- 37 lines of the FITCHRATINGS Global Format; 

- 6 Assets Quality Ratios; 

- 11 Capital Ratios; 

- 13 Operations Ratios; 

- 6 Liquidity Ratios. 

 

Click first the  button. A drop-down list appears, allowing you 
to select the type of financial data (e.g. Assets, Liabilities, Income Statement, etc..) as 
well as the variable on which your search will be based. When the type of financial data 
and the variable are selected, a dialog box (Figure 26) will enable you to: 

 

?? set a minimum or maximum limit (or both) for the variable under study. 
Financial figures must be expressed in million $ and ratios in percentage 

?? choose the year considered in the search 

?? select the type of statement (consolidated or not) by using the drop-down 
menu. 
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6.1.8.SEARCHING BY RATINGS 

A search can be conducted on the rating values provided by the following 
agencies: 

 

FITCHRATINGS  Long Term, Short Term, Individual and Legal; 

 

MOODY’S Bank Deposits (Long Term and Short Term), 
Long Term Debt, Financial Strength and 
Commercial Paper; 

 

CAPITAL INTELLIGENCE Foreign Currency Long term, Foreign currency 
Short Term, Domestic strength, Support 

 

THOMSON BANKWATCH Short Term Debt, Senior Debt, Subordinated 
Debt, Preferred Stock; 

 

STANDARD & POORS Short Term and Long Term; 

 

 

Click on the  button and select the type of rating from the drop-
down list. A dialog box will appear enabling you to select the value(s) desired for the 
rating. Just highlight the chosen lines by clicking on them and then on  to select these 
lines. Validate the search by clicking on . 

 

Note that clicking on  allows you to access the Rating Reports 
and list of ratings issued by the rating agencies that are hosted on BankScope. For more 
information, see Chapter 16. 
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6.1.9. SEARCHING BY AFFILIATIONS 

 

BankScope contains comprehensive information on the ownership and the 
banking subsidiaries of the institutions that are hosted on the disk. The ownership 
database is organised in the form of “links”, a link being defined by the following 
information: 

 

- parent company; 

- daughter company; 

- percentage of interest; 

- source of information; 

- date of information. 

 

 The sources is as follows: 

 

- Annual Reports; 

- direct contacts with the concerned institutions (twice a year a mailing is sent 
to all banks hosted on BankScope); 

- information published by the press; an analyst located in Brussels is 
exclusively devoted to the task of analysing the news on ownership that is 
published in the daily or periodical financial press; there is an average of 
about 5 news articles per day relating to modifications in the ownership of 
the banks; 

- information collected in the other databases distributed by Bureau van Dijk 
or in other published sources (when authorised by the concerned information 
providers). 



 

 

 

 
Figure 27 

 
Figure 28 

 
Figure 29 
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To conduct a search on affiliations, this criterion must be the first item in a users’ 
search. Click . A menu will allow you to select one of the four 
following options: 

 

?? Searching for the foreign banks in a given country 

 

The definition of what the user regards as “foreign” bank can be freely specified. 
You can for instance specify that in your opinion a “foreign” 5 bank can: 

 

- include no more than N “foreign” shareholders; 

- totalling together at least X % of interest; 

- include or, on the contrary, exclude any local shareholder. 

 

The dialog box enabling you to specify all this is presented in Figure 27. 

 

Figure 28 presents the list resulting from such a search (in our example: the 
Japanese banks in Germany, a “Japanese” bank being defined as a bank owned by a 
maximum of three Japanese shareholders holding together a stake of at least 75%, with 
possibly other “foreign” shareholders). 

 

??  Searching for the affiliates of a given bank  

 

 You can select a bank for which you want to find the parents and/or the 
affiliates. You can specify the minimum percentages that are to be taken into 
consideration for including an affiliate in the group for each of the following six 
categories: direct parents; indirect parents; direct subsidiaries of direct and indirect 
parents; direct subsidiaries; indirect subsidiaries; direct parents or direct and indirect 
subsidiaries. This can be done by using the dialog box presented in Figure 29. 

                                                 
5
 “Foreign” refers either to a single country (foreign to the “given” country) or to all countries foreign to the “given” country. 



 

 

 

 
Figure 30 

 

 

 
Figure 31 

 

 
Figure 32 
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??  Searching for the affiliations within a given set of banks 

 

After selecting a pre-designed file of banks, this search enables you to identify 
the banks in the file with financial links. 

 

Figure 30 shows the dialog box that enables you to decide on the level of 
percentage of interest to be considered in order to be included in the search. 

 

Figure 31 illustrates the result of such a search (six affiliations within a set of 
189 banks having an A, AA or AAA FITCHRATINGS rating). 

 

?? Affiliations between two banks 

 

Select two banks then in the dialog box shown in Figure 32 define the minimum 
percentage for a link to be included between them in the search. This enables you to 
find out if the two banks are directly or indirectly linked. 

 

6.1.10. SEARCHING BY UPDATED STATEMENTS  

 

This option allows you to select the statements that have been updated or revised 
since the previous update of BankScope. 

 

Click on the  button. The following menu will appear: 

 

 
 

Revised statements are statements that have been modified either because more 
accurate or detailed information has been obtained or because inaccuracies have been 
found and corrected. A bank’s ownership record is revised if the percentage of an 
already existing affiliation has changed, a new affiliation has appeared or if a new 
textual message has been added to the ownership record. 
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6.1.11.SEARCHING BY SAVED FILE 

This option allows you to retrieve any bank set files (with extension .SET, .BVD or 
.PGF) that have previously been saved. The same search can be accessed by the option 
“Open a bank set” from the “File” menu. 

 

6.1.12. MISCELLANEOUS 

 

Click the  button to display a dialog box that allows you to select banks 
according to the following criteria: 

 

Bank included in the ranking this option allows you to restrict your search to banks 
included in the world and country rankings. Non-
banking credit institutions, central banks as well as 
statements which do not offer recent information are 
excluded from ranking calculations; 

 

Consolidation code this option enables you to search for statements by one 
or several consolidation codes (see Chapter 2); 

 

Currency codes this option enables you to select all statements 
published in the currency selected; 

 

Number of available years this option enables you to select statements for a 
specified number (or numbers) of years; 

 

Last available year this option will select statements on the basis of the last 
available year; 

 

Type of Format this option will select statements on the basis of their 
format codes (see Chapter 2); 

 

Model (nickname) this option will select all the statements belonging to 
the same FITCHRATINGS model; 

Special Companion (SEC, etc..) this option will select all the statements with C* or U* 
consolidation codes; 

 

 



 

 

 

 
Figure 33 

 

 

 

 
Figure 34 
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Recently added statements this option will select all the statements which have 
been recently added to BankScope; 

 

Banks for which a note exists allows you to retrieve banks for which you have 
manually entered a note 

 

Search by word in notes displays a menu in which you can type a word to be 
found in the notes entered by the user 

 

Type of Shareholder displays a dialog box (see Figure 34) in which you will 
have the possibility to select the desired type(s) of 
shareholders (state, public authorities, individuals and 
private shareholders, companies and banks) as well as 
their ownership percentage. 

 

Search by Auditor’s name displays a list from which you can select the desired 
auditors. 

 

Listed/unlisted in the appearing window, you can select listed or 
unlisted banks. 

6.2. Result of a search 

Whenever you click on  in any of the dialog boxes allowing you to 
conduct a search, the result of the search is displayed along with the results of the 
previous searches. There are, at the end of the line, two columns containing figures (see 
Figure 33). 

- Step Result: the left-hand column indicates the number of statements of the 
whole database that satisfy that search criterion; 

 

- Search Result: the right-hand column indicates the number of banks that 
satisfy the combined criteria, every criterion being linked to the preceding 
one with the Boolean operator “and”. 

 

By clicking on any of the 13 buttons conducting the searches, you can restrict 
the search with a new criterion. Also note that if, at the end of a search, the name index 
is called upon (by clicking on the  button), the index will be reduced to the 
banks complying with the former criteria. This index is not permuted. 
 

At the end of a search, click on  to view the list of all selected 
statements (sorted by default according to Total Assets for the last available year or by 
any other sorting key previously defined by the user). 
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 By clicking on ,  the report of the first statement selected will be 
displayed. 

 

 By clicking on , group and peer group facilities of this module will be 
accessed for the current selection (see Chapter 9). 

 

 By clicking on , statistical analyses will be conducted on the 
statements selected (see Chapter 10). 

 

6.3. Modifying or deleting a search step 

When the cursor is positioned on a line corresponding to one of the search criteria used: 

 

 - clicking on the  button will delete that criteria; the results of the 
search will be instantaneously recalculated; 

 

 - clicking on the  button enables you to set new parameters for the 
highlighted criteria.



 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 35 
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6.4. Boolean search 

 As explained hereafter, the search criteria are, by default, combined with the 
Boolean operator “and”. 

 

 You can easily modify these different search criteria by using other Boolean 
operators. In order to do so, click on the  : the white control bar just beside 
this button becomes active. By using the “DEL” key, you can delete a part or all of the 
equation displayed and create an equation that suits you (do not forget the 
parentheses...). 

 

 
 

For instance, Figure 35 shows the result of the selection of large European 
commercial banks having either a Moody’s rating of Aaa, Aa, A or an 
FITCHRATINGS rating of A, A/B, B. 

6.5. Saving a search strategy 

Any search strategy sequence can be saved and re-used at a later date. This 
method will allow you to monitor banks that meet your criteria every time you receive a 
new update of BankScope. Obviously results may differ from month to month as 
company accounts are updated.  

 

To save your search strategy, select “Save the search strategy” from the “File” 
menu.  A dialog box will appear allowing you to give a name to your search (your file 
will automatically be given the .srh extension). Click on the  button for saving. 

6.6. Saving bank sets 

Saving a bank set enables you to retrieve the identical group of banks at a later 
date, as you save the index numbers of the banks and not the criteria. 

 

To save your bank set, select “Save the bank set” from the “File” menu. A 
dialog box will appear where you must give a name to your bank set. It will be 
automatically given the .set file extension, but you can change this extension depending 
on your needs. 
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Three types of files can be created: 

 

Type [*.set] :  the file includes all the financial data relating to the saved banks. Such 
files will be used for conducting Peer Group and Statistical Analyses 
(See Chapter 9 and 10). 

 

Type [*.bvd] :  the file includes only the index numbers of the selected banks. Group of 
banks must be saved using this extension for use with BankScope’s 
Add-In feature (See Chapter 12). 

 

Type [*.pgf]:  once the file is saved with a pgf extension, it can be assigned as Own 
Peer Group to a bank or a group of banks. (See Chapter 9) 

 

6.7. Saving a Peer Group 

Choosing File-Save the Peer Group will allow you to create your own peer 
group on the basis of the result of your search and to associate the peer group to the 
banks retrieved after this search or to additional banks. You can afterwards manage your 
peer groups and associate other banks to them by choosing File-Associate companies to 
existing peer groups (for more details, see Chapter 15).  

 

The file will be saved in your User folder with a *.pgf extension (see above). 
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7.  CUSTOMISED FORMATS 

You can easily create one or more Customised formats.  The Customised Formats are 
defined as a presentation of accounts including selections or groups of financial data or 
ratios. 

To create a own Customised format, choose Options-Customised Formats. The 
dialog box illustrated in Figure 21 will appear on the screen. 

7.1. Name of the customised formats 

 A name is given by default to the accounts you are creating. It can be modified 
by clicking on the default name and by typing in a chosen name. The  button 
will delete the customised format currently displayed. 

 

NOTE: The customised formats are saved in your user folder with *.CUS extension. 
The content of the file can be edited with a text editor like Notepad. 

7.2. Selecting the FITCHRATINGS model 

 You first have to select the FITCHRATINGS “Model” with which you want to 
associate your customised format. If you use the “Global” model, your own format will 
be able to process any statement, whatever the country or the specialisation. If you 
select another model, your own format will be able to present only the statements coded 
by FITCHRATINGS in this model. 

7.3. Selecting Lines 

Select first the section from which you want to select lines: Header, Profile, 
Global, Spreadsheet, Raw Data, Ratios, Own Ratios  

To select a single line, position the cursor on it and click on the  button (or 
double click the line): this line will be moved to the window on the right. In the left 
window, the colour of the selected line changes. [You can select it several times if you 
need to display it at several places]  

 

If you want to regroup lines, click on all the desired lines (if these are adjacent, 
you must keep the left button of the mouse pressed or hold down the “SHIFT” key; if 
these are not adjacent, you must at the same time press the “CTRL” key) and click on 
the . 
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A dialog box appears. It displays the selected items and enables you to give a 
title to the resulting line in the new format (by default, the name of the label will be 
Subtotal). By default, all the lines are added, but you can change the signs of the lines 
by selecting them and clicking the  button. When the title and the signs are 
correct, click on “OK”. Only the line regrouping these items will be displayed 

The  button removes the selected line form the right window. Use  to 
remove all the lines. 

When you click , the subtotal will automatically be displayed below all 
selected lines (a small arrow appears in front of it). If you want to move one line, select 
the line in the right pane and click the  button. Select the new location for the 
line and click : the line will be placed immediately above the line you selected 
before clicking . You can also move the lines by pressing ALT and ?  or ?  on 
your keyboard. [this operation can also be completed in the “make-up” procedure 
described hereafter]. To edit the formula you created for the subtotal, select the subtotal 
and click  again. 

Clicking the  button will display a dialog box enabling you to create 
your own ratios (also called user defined variables - see Chapter 8). These ratios are 
associated with lines of the format you are building. They will not appear in the “user 
defined variables” section of a report. 

The  button will allow you to retrieve a line containing a specific string or 
with a certain line number and to position your cursor on it (see Figure 37). 
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7.4.Make-up 

By clicking on this button you will display a dialog box presenting the existing 
lines of your customised format and enabling you to improve the presentation (see 
Figure 38). The following features are offered: 

 delete the highlighted line; 

 creates a total for the items created by the user. First 
highlight the desired items then click this button ; 

 inserts a dotted line above the highlighted line; 

 inserts a single line that runs across the page; 

 inserts a double line that runs across the page; 

 inserts a blank line just above the highlighted line; 

 inserts a title above the highlighted line; 

 moves (to the right) the label on which the cursor is 
positioned; 

 moves (to the left) the label upon which the cursor is 
positioned; 

 changes the sign of the highlighted line; 

 displays a dialog box enabling you to change the label; 

 the line is still used in the calculation but is not displayed 
on the screen; 

 the programme will set this item to 100% for the 
calculation of the relative sizes of the Balance Sheet items; 

 same as previous, but for the Income Statement; 

 the highlighted line will be the first to print on the next 
page. 



 

 

 

 
Figure 39 

 

 
Figure 40 

 

 
Figure 41 
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7.5. Using the Text Mode  

Instead of modifying the formats as described above, you might use the Text 
Mode, which will allow you to type in the formulas and the labels at the same time. To 
switch to this mode, click the  button at the bottom of your “Design your own 
customised format” dialog box (see Figure 36).  

This displays a window (see Figure 39) allowing you to edit an existing 
customised format or to create a new customised format on the basis of an old one. The 

 button lets you go back to the main screen. 

7.5.1.EDITING AN EXISTING FORMAT  

The Text mode window contains mainly three columns: 

?? Code: this column contains an internal number for the line (BVD+4 digits) 
which is automatically generated. This allows you to refer to that line in 
another formula. 

?? Label: type in this column the name that should be used as the title of the 
line. 

?? Definition: type the account number that should be displayed on this line or 
any formula using the account numbers. Use operators and parenthesis if 
needed, as you would in a spreadsheet. Note that if you use a constant in 
your formula, it must be preceeded by a ‘#’ to differentiate it from an 
existing account number.  

7.5.2.CREATING A NEW CUSTOM ISED FORMAT BASED ON AN EXISTING ONE 

If you wish to create a new customised format having the same structure and/or 
definition as an existing one, simply display the customised format in the “Design your 
own customised format” dialog box (see Figure 21). Type the name for your new format 
in the Format box at the top of your screen and click . The dialog box 
displayed in Figure 40 will appear on your screen: check the tick box Create a new 
customised account with this name and click . 

You now have to select the new format and to edit it according to your choices. 
If necessary, change the model to which this new format will apply by selecting another 
model in the drop-down list. The dialog box displayed in Figure 41 will appear on your 
screen. Select the appropriate option and click .  

 

NOTE: If you change the model to which you apply the new format, make sure the 
account numbers still refer to what they should. Indeed, the same account 
number does not refer to the same financial item for the spreadsheet and raw 
data formats, which are country specific. 
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8.  USER DEFINED VARIABLES 

There are two ways to access the dialog box (Figure 42) enabling you to build 
your user defined variables: 

?? by choosing “User Defined Variables” from the “Options” menu: in that case, the 
created variable will be part of the User defined variables section associated with a 
report and can be included in any own report format.  

?? by clicking the button  when designing a customised format: in that case, 
the user defined variables will be attached to the customised format and will not 
appear in the User Defined Variables section attached to reports displayed in another 
format. 

8.1. Name of the user defined variable 

A default label is presented in the dialog box. Just type the new name in. 

8.2. Creating a user defined variable 

We advise you to first prepare your formula on paper. Then, two methods can be 
considered: 

8.2.1.FIRST METHOD 

?? double click the first item; 

?? click the operator that will precede the next item: addition (+), subtraction (-), 
multiplication (X), division (/) or absolute value (? ); 

?? double click the second item; 

?? repeat the same procedure for all the items; 

?? select the units (if you have chosen “Percent %”, you have to multiply the formula 
by 100). 

Do not forget to introduce parenthesis, if necessary, according to the usual 
mathematical rules. Note that if you use a constant in your formula, it must be 
preceded by a ‘#’ to differentiate it from an existing account number. 

 

According to the position of the superior radio-button, each item can be taken 
for year N (the most recent year), year N-1 (the second most recent year), or as average 
for the last two years. 
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8.2.2.SECOND METHOD 

Just type the formula (by using the line numbers of the items; once again, do not 
forget the parentheses or to multiply by 100 if the units are in percentages - do not type 
an equal sign to start your formula). 

By default, the values associated with year N will be obtained. In order to take 
the values of N-1, type the string [N-1] just behind the line number or [M] to take the 
average of the two last years. 

 

Note that if you use a constant in your formula, it must be preceeded by a 
‘#’ to differentiate it from an existing account number. 

 

In both cases, the test area at the bottom of the screen will let you preview a 
value of the ratio. This ratio will be automatically calculated for a realistic fiction bank, 
so that you can check whether the formula gives plausible results. 

8.3. Associating a limit to a ratio 

You can assign a lower or an upper limit (or both) to your ratio: if the value 
calculated is inferior to the lower limit or superior to the upper limit, you can specify: 

?? the value of the limit; 

?? “ns” for non significant; 

?? another value (this can be very useful if this ratio is included in an automatic credit 
scoring program). 
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9.  PEER GROUP ANALYSES 

9.1. Overview and terminology 

A clear distinction must be made between a “Peer Analysis” and a “Statistical 
Analysis”.  

A “Peer Analysis” compares a bank (the “Subject Bank”) to the median, the 
quartile, the deciles and/or the average of a Peer Group or to a given set of individual 
banks. The “Subject Bank” may or may not belong to the Peer Group. 

A “Statistical Analysis” studies a group of banks without bringing to the fore 
any particular bank of the group. 

9.2. Typology of Peer Analysis 

Three types of Peer Analyses can be conducted, according to the entities used 
for the comparison, that we call A, B or C: 

??Peer Analysis A: the items selected for the Subject bank are compared to the 
deciles, quartiles, median and/or the average of the distribution of the same 
items in the Peer Group. 

??Peer Analysis B: ibid, but in addition to the Peer Group, you can add to the 
comparison a few individual banks that we call ‘Comparison Banks’. (For 
instance, your Subject Bank is Dresdner Bank and you wish to compare its 
values to the median of all German commercial banks; but, at the same time, 
you want to see the values taken by Commerzbank and Deutsche Bank). 

??Peer Analysis C: you wish to compare the  subject bank to a given set of banks 
with figures shown for each of them. 

9.3. Accessing Peer Analysis 

Peer analysis can be accessed in four different ways: 

??when a single bank has been selected and its report displayed, by clicking on 
, the bank displayed will automatically be considered as the subject 

bank and the peer group will be your current own peer group, the standard peer 
group or a previously saved set of banks; 

??At the end of a search (when several companies have been selected even if this 
search has been conducted by the Bank name index): by clicking on 

, the subject bank  will be one of the selected companies. 



 

 

 
Figure 43 

 
 

 
Figure 44 
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PEER GROUP ANALYSES 

 9 - 3  

By loading a bank set : see the former case; 

?? Direct access: if you click on  without having loaded any bank set or 
search strategy, you will be able to select at the same time the subject bank and 
its eventual peer group. The peer group will be a bank set file or a default peer 
group. 

 

Note that all tables and graphics described in this Chapter may be copied and 
pasted into other packages. 

9.4. “Type A” Analysis: a bank compared to a peer group 

The subject bank is selected from the Bank name index. 

A dialog box enabling you to select the peer group is displayed (see Figure 43). 
This can either be: 

 

??the statements found at the end of the search; 

??your current own peer group; 

??the standard peer group; 

??any other bank set file or peer group file that has been previously saved and 
associated to the bank. 

 

A table presenting the results of the analysis is displayed (see Figure 44). This 
table is by default presented with the variables and the ratios of the Profile Format for 
the last three available years. The  button enables you to change the variables 
displayed. 

9.5. “Type B” Analysis: a bank compared to several individual banks and to a 
group 

The procedure for building the comparison table is the same as discussed in 
section 9.4. except that you will also have to select the comparison banks. Once again, 
the comparison banks will necessarily belong to the selected banks if this analysis is 
carried out after a search or after loading a bank set file. The peer group can be freely 
chosen. 

 

An example of such analysis is showed on Figure 45.



 

 

 
Figure 46 
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9.6. “Type C” Analysis: a bank compared to one or several individual banks 

The procedure is the same as in section 9.5, except that you do not select a peer 
group. 

9.7. Buttons and Icons at the bottom of the comparison tables 

Below the comparison tables, there is a menu bar with nine buttons and four 
icons: 

 

  Case A: if several subject banks are selected, clicking on this icon will 
display the table relating to the former or the next bank. The peer group 
remains the same except if a default peer group is used : in that case, the 
default peer group corresponding to the subject bank will be used; 

 

 Case B and C: the button rotates the subject bank and the comparison 
banks; 

 Case A and B: displays a dialog box that enables you to exclude (and re-
include) one or several banks of the peer group. Such a dialog box is 
shown in Figure 46. A bank is excluded by double-clicking just in front 
of the name. The “+” sign becomes a “-”. You can select several banks at 
once by holding the button of the mouse and by clicking on “Exclude 
from the selection”. 

 

 The excluded banks can be saved in a file by clicking on the “Save 
Companies” button and by giving a name to the file. The original bank 
set will remain unchanged. 

 

 The banks of the list can be sorted alphabetically (default sorting) or by 
variable for any of the available years. 

 

 Remark: this button is deactivated if the peer group is a standard peer 
group because in that case, it is not possible to exclude banks of the 
group. 

 

  Case C: allows you to exclude from the table one or several banks. 

  displays a menu that enables you to select a presentation made up of the 
currency, the units and the type of exchange rates (official or own rates) 
or a previous presentation. If you click “New presentation”, the dialog 
box shown in Figure 47 is displayed. 



 

 

 
Figure 48 
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 allows you to select a set of variables (financial data or ratios) for 
which the comparison will be carried out or to create a new set of 
variables (this is also possible via the “Option” menu - see Chapter 
15); 

 

 displays a dialog box that enables you to select the years for which 
the analysis will be carried out; 

 This button displays the dialog box in Figure 48. It allows you to 
choose what parameter (rank, decile, quartile) you wish to display 
for each variable and what values should be displayed for each 
variable (median, average, standard deviation, etc). 

 This button allows you to toggle the position of rows and columns 
(the values for the subject bank  will be displayed in the first 
horizontal line of the screen instead of being displayed in the far-left 
column for each year) as shown in Figure 49. 

 goes back to the table when a graphical illustration is displayed. 

 



 

 

 
Figure 50 

 

 
Figure 51 
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Four graphical illustrations are associated with a comparison table. These can be 
displayed by clicking on the following icons: 

 

  displays a bar chart (Figure 50) which illustrates the evolution of a 
variable for the subject bank compared to the values taken for this same 
variable by the comparison banks  (case B and C) and by the median of 
the peer group (case A and B). In this last case, the average and the 
standard deviation can be added to the graph. The  button which 
lets you exclude banks from the peer group is always present. 

 

The variable under study can be modified by clicking in the upper-right 
pane of the window. The set of variables available for the illustration can 
be modified by clicking on . The  button enables you to change 
the period illustrated. The  button allows you to specify the 
currency, the units and the type of exchange rates. 

 

 The button  inverts the subject bank and the comparison banks. 

 

The bars relating to the group (median, average and standard deviation) 
are not displayed if the group includes less than 3 statements. 

 

 Note that the radio-button “by year / by company” gives you the 
possibility of showing side by side the data relating to each entity (the 
subject bank, comparison banks, median, average, standard deviation) 
rather than those relating to the year (see Figure 51). 

In addition, the check boxes Median, Average, Std. Dev. allow you to 
decide from the graphical illustration whether you wish to view the 
median, average and standard deviation represented on your chart. 



 

 

 
Figure 52 

 

 
Figure 53 
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 displays a diagram (Figure 52) showing the distribution of one variable 
within the peer group: blocks present the values of the quartiles as well as 
the lower and upper limits of the distribution. 

 

  The values taken by the variable for the subject bank as well as for the 
comparison banks are illustrated by the horizontal dotted lines. A check 
box allows you to delete lines relating to the comparison banks. 

 

  The interquartile relative interval is the difference, in percentage, 
between the third and the first quartiles divided by the median. 

 

  The buttons , ,  and  have the same 
functions as in the former graph. 

 

It is interesting to note the following: as a distribution can be strongly 
influenced by extreme values, it is possible to eliminate these values by 
excluding the first and last deciles of the graph (by clicking on the “First 
and last deciles” radio-button). In that case, a graph similar to Figure 53 
is obtained. 



 

 

 
Figure 54 

 

 

Figure 55 
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  displays a diagram (Figure 54) showing the evolution in deciles of a 
variable for the subject bank, the banks of the peer group as well as for 
the median, the average and the standard deviation of the peer group. 

 

  The year base (for which the value of the variable represents 100%) can 
be changed by clicking in the upper right window. 

 

 NOTE: a line will be displayed only if a value is available for the year 
base. Consequently, changing the year base can make a line of the graph 
appear or disappear. 

 

  displays a diagram (see Figure 55) showing the evolution of a variable 
within the deciles of the Peer group (for the subject bank or any bank of 
the peer group). 

 

 NOTE: as for the diagram showing the distribution of a variable, it is 
possible that one or more points relating to the subject bank (or banks of 
the peer group) appear outside the limits of this diagram. This is the case 
when the subject bank (or the banks of the peer group) is not part of the 
peer group. 

 

Only the first of these diagrams is associated with the table relating to a 
type C analysis because, in that case, there is no peer group. 



 

 

 
Figure 56 
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9.8. Associating your own Peer Group to a bank 

Before being able to compare a bank to an own Peer Group that you would have 
saved after performing a search (see chapter 14.1.2), you have to associate it to the 
bank.  

To do so, after having saved your own Peer Group6, from the list or the report 
screen, choose File-Associate Companies to existing Peer Groups. The window 
illustrated in Figure 56 will be displayed. 

In the left pane of this window, you will see the list of selected banks and in the 
right pane, the list of existing own Peer Groups. To associate one selected bank to an 
own Peer Group, select the bank from the left pane and the Peer Group to which you 

want ot associate it from the right pane. Click on . 

You can associate one bank to more than one own Peer Group by repeating this 
last step. In this case, you may choose a default peer group: check the tick box in the 
middle column. 

To suppress the association between a bank and a Peer Group, select both the 

bank and the Peer Group and click on the  button. 

The  button allows you to choose more banks directly from 
this window to let you associate them to existing Peer Groups. 

You can also change the current own Peer Group from the report screen (please, 
refer to 4.1). 

 

                                                 
6 All bank being part of a saved own Peer Group are associated to it by default. 
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10.  STATISTICAL ANALYSES 

10.1. Overview 

A Statistical Analysis studies a group of banks without emphasising any 
particular bank of the group. 

10.2. Typology of the statistical analyses 

BankScope offers five different types of statistical analysis: 

 

- aggregation of the group; 

- distribution of a variable; 

- concentration analysis; 

- linear regression; 

- group reports. 

10.3. Accessing the statistical analyses 

The statistical analyses can be accessed in three different ways: 

?? At the end of a search: by clicking on . The analysis will be 
conducted on the group of banks selected at the end of the search;  

?? After loading a bank set: the analysis will be conducted on the banks found 
in the bank set file; 

?? Direct Access: by clicking on  without having selected banks or 
loaded any bank set, whenever you select a type of analysis, you will be 
asked to select the bank set on which you want to carry out your analysis. 

 

When viewing the results, whatever the used statistical analysis, a  button 
will allow you to exclude one or several banks from the group - exactly as for the peer 
group analysis. 
 

Note that all tables and graphics described in this Chapter can be copied and 
pasted into other packages. 



 

 

 
Figure 57 

 
 

 
Figure 58 

 

 
Figure 59 
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10.4. Aggregation of the group 

This analysis consists in aggregating the accounts of a group of banks in order to 
assess their sum total. For example, you may use this analysis to ‘merge’ two banks, or 
to estimate the size of a country’s banking system. 

10.5. Distribution of a variable 

This module presents the distribution of any variable (financial data or ratio) for 
the group of selected banks. 

A table presents (see Figure 57) the results of the analysis. It shows the values of 
the quartiles and the deciles of the distribution, as well as the average and the standard 
deviation. The rank of the bank is given in the list in the upper window (this list can be 
sorted alphabetically or according to the variable under study). 

The distribution is illustrated by two graphics that are displayed when clicking 
on the following icons: 

 

  displays a bar chart representing the distribution in classes and showing 
the number of banks of each class (Figure 58). The vertical dotted lines 
correspond to the values of the quartiles; and the red hyphen line 
corresponds to the bank selected in the upper pane. 

 

  displays a diagram (Figure 59) similar to the one described in the section 
 of the peer group comparison (see Chapter 9). The bank highlighted in 
the list in the upper window is represented by a red dotted line in the 
diagram [This list can be sorted either alphabetically or according to the 
descending values of the variable under study]. 

The first and last deciles can be excluded from the diagram by checking 
the “Include/Exclude” radio button. 



 

 

 

 
Figure 60 

 

 
Figure 61 

 

 

 

 

 

 

 
Figure 62 

 

 
Figure 63 
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10.6. Concentration analysis 

This analysis enables you to determine the share of a financial variable or a ratio 
held by each bank in your group of banks. The table resulting from this analysis is 
illustrated in Figure 60 where the values for the variable under study are displayed for 
each bank of the group - sorted by descending order - along with the cumulated values 
(in value and in percentage). If the variable is negative for some banks of the group, 
separate tables are created for negative and positive values. Three graphical illustrations 
are associated with this analysis. They can be accessed by clicking on the following 
icons: 

 

 

  displays a “pie-chart” (Figure 61) illustrating the contribution of each 
bank to the cumulated value of the variable under study for all selected 
banks. The drop-down list at the bottom right of the window are used to 
specify the number of banks presented on the graph (from 2 up to 10), the 
position of the first represented slice and the viewing angle of the pie; 

 

  displays a Lorenz curve (Figure 62) which shows the contribution for the 
cumulated variable of a given percentage of banks of the group. For 
example, the first 4 banks (20% of a group of 18 banks) represent 35% of 
the Equity figures for 1998. 

 

  The bank highlighted in the top window is shown on the curve by a blue 
stroke. 

 

  The area between the Lorenz curve and the diagonal of the diagram is a 
measure of the degree of concentration presented within the group for the 
variable under study. 

 

  displays a bar chart (Figure 63) presenting, in descending order, the 
values taken by the variable for the different banks of the group. A 
vertical blue line indicates the position of the bank selected in the upper 
window. 

 



 

 

 
Figure 64 

 

 
Figure 65
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10.7. Linear Regression 

This module calculates the linear regression between two variables which can be 
specified among a set of financial data and ratios by a dialog box, for any year available. 

 

A table shows the values observed for the independent variable, observed and 
calculated for the dependent variable as well as the correlation coefficient. 

 

A diagram (Figure 64) illustrates the regression. The bank highlighted in the list 
at the top of the screen [which can be sorted either alphabetically or in descending order 
according to the value of the dependent or the independent variable] is represented by a 
blue point in the diagram. Conversely, by clicking on any point of the illustration, the 
corresponding bank will be highlighted in the list at the top of the screen. 

 

Remarks: 

 

a) It must be emphasised that this illustration is a mapping of two variables on a 
diagram rather than a regression diagram stricto sensu. Indeed, experience shows that 
there are few cases where correlation coefficients are significant.... 

 

b) As the scales on the axes are modified according to the values taken by the variables, 
you can improve the representation by excluding banks for which the variables - 
dependent or independent - take extreme values... 

10.8. Group Reports 

BankScope’s group reports produce tables in which the banks are listed in the 
rows and variables or years in the columns : 

 

- one variable for several years; 

- several variables for one year; 

- several variables for several years. 

 

A report of the third type is illustrated in Figure 65. Besides the standard buttons 

, ,  and , you will find two other buttons: 

 

- the  button allows you to include in the table any information from the 
Header section, including the rankings and the ratings; 
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- the  button allows you to display between brackets the position of each 
bank in the deciles (or the quartiles) of the group for any selected variable. The ranks 
can also be displayed. You can also select in which column of the report the position 
has to be displayed. 

 

- the sort drop-down menu allows you to present  the banks in alphabetical order 
or in descending order according to the selected variable (for any year available); 

 

The  button enables you to select a pre-defined set of variables or to create 
a new one. The  button enables you to select the currency, the units and the type 
of used exchange rates (official or own rates). 



 

 

 
Figure 66 

 

 
Figure 67 

 

 

 
Figure 68 
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11.  INPUTTING AND MODIFYING DATA 

11.1. Introduction 

This module will allow you to add your own information in BankScope if 
necessary. It can be accessed by the “Own data” option of the “File” menu. A dialog 
box illustrated in Figure 66 presents: 

 

- on the right, the list of banks that have been added or modified; 

 

- on the left, the following four buttons: 

 

 enables you to add a new bank to BankScope; 

 

 allows you to modify the data supplied on BankScope or to add 
one or several years of data; 

 same function but for one of the user input banks listed (click first 
on the line desired in the list); 

 delete, after clicking on the desired line, a bank from the list. 

 

If you add a bank or input data for an existing bank, your work is saved in the user 
directory. You will not affect the content of the CD itself. 

11.2. Adding a new bank to BankScope  

Clicking on  displays the dialog box in Figure 67 that allows you 
to specify the identifiers of the new bank. 

 

When this is completed, click . You must then specify in the 
corresponding dialog boxes: 

 

- the format of entry (e.g. Global Format, Spreadsheet Format or Raw data format );  

- the years for which you want to input the accounts, as well as the closing dates. 
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Afterwards, all the lines of accounts for which you have to do the input are 
displayed (Figure 68). Use the arrow keys ? ? ? ?  to move in that screen. Note that 
Total Assets, Total Liabilities and Net Income are always calculated and displayed in 
the three sub-total lines at the bottom of the screen. 

 

The  button allows you to save your work at any time. 

 

When the input is completed and saved, you are ready to use your report, as well 
as the associated illustrations. 

 

The  button takes you back to the main screen. 

11.3. Modifying and updating an existing BankScope bank 

When you click on , the Name index appears for selecting the 
bank or banks to which you want to add one or several years of accounts or for which 
you want to modify the existing data. At the bottom of the report of the first bank 
displayed, there are three buttons , and  . The first two have the same 
function as described in section 11.2. Adding a new bank to BankScope. The   
button enables you to select one of the four following options: 

 

 
 

Modify the header clicking on this button displays the same screen as 
described in section 11.2 but where the header of 
BankScope is presented by default. You can type the 
modifications by clicking on the desired fields. 

 

Add one or more years displays a window displaying the existing years. You 
have the possibility to modify the periods, closing year, 
qualification of an existing year or to add one or several 
years by clicking the Add button.  

 

Modify the existing statement displays the accounts in the active window where you 
can click on any item after choosing what format entry 
you desire. 
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Update data from the CD-rom when you choose this option, a dialog box asks you 
what years you wish to update. Select the years and 
click ok. The figures will be taken back from the the 
CD you are using. This is useful if you wish to replace 
your input by the data from the CD-ROM once the data 
has been input by FITCHRATINGS. 

 

When a report is displayed, you are able to directly access this procedure by 
clicking on the “Owndata” option from the “File” menu.[The menu of Figure 66 will 
not be displayed] 

11.4. Modifying a bank of the list 

The procedure is the same as in section 11.3 except that the bank is selected 
from the list from Figure 66 and not from the Name index. 

11.5.Removing  a bank from the list 

Just click on the bank you want to delete and then click on the  
button. 
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12.  BANKSCOPE PRESENTATION SOFTWARE 

 Any report produced within BankScope may be printed, downloaded or 
transferred into the following formats: Excel, Lotus, ASCII (delimited) and Multiplan 
(see Chapter 14). 

 However, BankScope also offers four additional functions to enable further 
customizing or mass downloading of data : 

 

??the “ADD-IN” for Excel; 

??the "ADD-IN" for Access; 

??the “BANK CREDIT REPORT”; 

??the Scoring Wizard For Access; 

12.1.Bureau van Dijk Add-In For Excel 

The purpose of this Add-In is to allow users to freely design tables containing 
bank data in Microsoft Excel. All features in Excel can be used to perform tailor-made 
calculations and create sophisticated templates. Note that once the template is created, it 
can be applied to other banks: selecting another bank will update all the information on 
the Excel sheet. A typical example is the credit scoring models. Group Reports 
presenting several banks in the same workbook can also be easily created. 

 

It must be stressed that the creation of such templates implies a good knowledge 
of EXCEL and its macro instructions. Most users won’t be able to construct such 
models on their own. The analysts of Bureau van Dijk will be happy to assist 
BankScope users in designing such templates. Note that a minimum of 2 hours (up to a 
day according to the level of complexity) is required to build such models. 



 

 

 

 

 

 

 

 

 

 

 
Figure 69 
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12.1.1. INSTALLING THE ADD-IN FOR EXCEL 

Start Excel, choose File-Open and select bvdaddin.xla7 in the SCOPE32 folder. 
Click the OPEN button. If a message asking you whether you want to enable macros or 
not appears, choose”Enable Macros”. The following commands are now available from 
the Tools menu:  

.  

If you open the add- in using this method, it will no longer be available after you 
close Excel. If you want it to be available during every Excel session, choose the Excel 
Tools-Add-ins command. Click the Browse button and select bvdaddin.xla in the 
SCOPE32 folder. A Bureau van Dijk 32-bit Add-in tick box appears in the list: as long 
as it is checked, the BvD Add-in will be available from your tools menu every time you 
start Excel. 

 

12.1.2. USING THE ADD-IN FEATURE 

In a new Excel workbook, choose Tools-BvD Add-in. The dialog box in Figure 
69 appears.  

It allows you to specify what data will be imported and how it will be imported. 

 

Variables: choose the variables you want to import from the list. The New Set 
button allows you to select other variables: the set will be saved 
automatically. 

 

Periods: by clicking the Change button, you will have the possibility to select 
the years (fixed, relative, interim) to be displayed on the spreadsheet. 

 

Cell options: If you tick the Updated values radio button, the spreadsheet will be 
automatically updated whenever you open. Indeed, in this case, every 
cell contains a formula with the following structure: 

                                                 
7
 This file needs to be installed during the setup procedure of BankScope (see Chapter 18) 



 

 

 
Figure 70 

 

 

Figure 71 

 

 
Figure 72 
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=BvD.GetCdData32 (“BANKSCOPE”,Index Number,Currency,Unit,Year,Line Number) 

 

where every parameter, except the first which is the name of the 
database, refers to a cell on the sheet in absolute reference, for 
example, the formula in cell D10 from Figure 70. 
=BvD.GetCdData32("BANKSCOPE",$A$4,$A$1,$A$2,D$5,$B10) 

 

Sheet creation: depending on the radio button you tick (all on one sheet: the resulting 
sheet will extend vertically, 2 dimensions per sheet: you will have 
several sheets as a result, all in one table: the resulting table will 
extend horizontally), the layout of the resulting sheet will change. You 
can preview the result just below the radio buttons. Additiona l options 
may be specified thanks to the other three radio buttons to the right. 

 

Presentation: allows you to define the units and the currency of the figures to be 
displayed on your sheet. 

 

 click this button to select the banks you want to display on your 
spreadsheet according to the same search criteria as in BankScope. 
Proceed as if you were working in BankScope. After you have defined 
several search criteria, you can use the  button at the bottom 
of the screen to edit the selected search step or click the  step 
button to delete it. 

Use  to delete all search steps. 

 

 click this button to import the data in Excel according to your choices. 

NOTES: 

??The File menu offers you the possibility to save your search strategy (Save the 
search strategy) or to make use of an already saved one (Load a search 
strategy), whether it was saved from Excel or from BankScope. The search 
strategies are files with a ".srh" extension which are located in your user folder. 

??The Language menu allows you to select another language for the menus and 
buttons in this BvD add-in window. 

??The Options menu offers you several additional commands, among which the 
possibility to specify the exchange rate as well as the access to updated 
financial data directly via the internet by clicking the Access Mode option. 
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12.1.3. THE EXCEL ADD-IN FORMULA STRUCTURE 

As any other Excel formula, the ADD-IN formula is recalculated whenever the 
file is opened or if any of its parameters changes. 
 

The ADD-IN formula structure is the following: 
 

=BvD.GetCdData32 (“BANKSCOPE”,Index Number,Currency,Unit,Year,Line Number) 
 

Let’s examine the parameters of this formula in details: 

 

DISK the name given to the CD-ROM : BANKSCOPE. 

 
 

INDEX NUMBER the Index Number of the Bank (For example 10028 for Banque 
Bruxelles Lambert -Consolidated).  

 

CURRENCY the ISO code (USD, DEM etc...) of the currency in which the data 
will be displayed. If the reference cell just contains an apostrophe, 
it means that the original currency of the statement will be 
displayed. 

 

UNIT the settings of the units used. The following values can be used: 

 
 -1  Original unit of the statement 
 3 Thousands 
 6 Millions 
 9 Billions 
 

YEAR the year which corresponds to the data displayed.  

 
 

For fixed Years, use : 
 
Year-End Data:  Interim Data: 
“1998”   “1998/Q4” 
“1997”   “1998/Q3” 
“1996”   “1998/Q2” 
“1995”   “1998/Q1” 
….   … 
 

For relative years, use : 
 
Year-End Data  Interim Data 
“LY”   “LQ” 
“LY-1”   “LQ-1” 
“LY-2”   “LQ-2” 
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LINE NUMBER the line number of the data to be displayed. (For example 2025 
will display the Total Assets of the Bank). Any line from the 
Global Summary, Global Detailed, Spreadsheet or Raw Data 
formats can be accessed. 

This parameter may also be used for displaying data on 
shareholders, subsidiaries and Standard Peer Groups (see 
hereafter). 

 

Example: 

The following formula: 

 
=BvD.GetCdData32 (“BANKSCOPE”,”10028”,”USD”,”9”,”1998”,”2000”) 

 

would display line 2000 (which is the line number of Total Loans) in billions USD of 
the Bank ‘Banque Bruxelles Lambert’ for 1998. 
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1 2 . 1 . 3 . 1 . S E L E C T I N G  A  B A N K  W I T H  T H E  A DD - I N  F O R M U L A  

 It is possible to select a bank and enter its index number directly in the current 
cell. This is done by typing CTRL-E.  The BankScope bank name index is displayed. 
When the statement is identified and selected, click on OK .  

The index number of the statement selected will be downloaded into the current 
cell. If the add- in formulas of the sheet make reference to this cell, all calculated cells 
will be automatically changed. 

1 2 . 1 . 3 . 2 . S E L E C T I N G  A  G R O U P  O F B A N K S  W I T H  T H E  A D D- I N  F O R M U LA  

Instead of selecting only one bank, you can select a group of banks from Excel. 
To do so, press the shortcut key CTRL-M. A dialog box displays, allowing you to 
select new search criteria or to edit old ones. Proceed as you would in BankScope to 
modify the search and click OK. 

 

The index numbers corresponding to each bank matching your search criteria 
will be inserted in the cells. 

If the add- in formulas of the sheet make reference to those cells, all calculated 
cells will be automatically updated. 

 

NOTE: If you click the Search/Add Step button and choose Saved file, you will have 
the possibility to load a set of banks that you will have saved beforehand with 
a .bvd extension (see above). 
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1 2 . 1 . 3 . 3 .  R E T R I E V I N G  S H A R E H O LD E R  A N D  S U B S I D I A R Y  D A T A  W I T H  
T H E  A D D - I N  F O R M ULA  

In addition to financial data, shareholder and subsidiary data can also be 
accessed via the Add-In. To do so, the Add-in formula needs to be adapted as follows: 

 
=BvD.GetCdData32 (“BANKSCOPE”,Index Number,Currency,Unit,Indices,Line Number) 

 

??the following numbers will replace the Line Number parameter according to the 
type of information you wish to display. Do not forget the minus sign. 

 
Shareholder’s Data Line Number   Subsidiary Data Line Number 

Shareholder’s Name -501   Subsidiary Bank Name -511 

Shareholder’s Country -502   Subsidiary Country -512 

Shareholder’s Direct Percentage -503   Subsidiary Total 
Percentage 

-513 

Shareholder’s Total Percentage -504   Subsidiary Source -514 

Shareholder’s Source -505   Subsidiary Date -515 

Shareholder’s Date -506   Subsidiary Total Assets  -516 

Shareholder’s Total Assets  -507   

 

??The Indices (e.g. 0 for the first shareholder, 1 for the second etc...) replace the 
YEAR code parameter. 

Example : 

The following formula displays the name of the first shareholder of BBL: 

=BvD.GetCdData32 (“BANKSCOPE”,”10028”,”BEF”,”9”,”0”,”501”) 

Note that the Unit code and the Currency code are not relevant here since the 
information is textual. 

1 2 . 1 . 3 . 4 .  A C C E S S I N G  S T A N D A R D  P E E R  G R O U P S  A N D  C U R R E N T  O W N  
P E E R  G R O U P S  W I T H  T H E A D D - I N  F O R M U L A  

Standard Peer Groups can be used in the Add-in function. The Line Number 
parameter (which is the last parameter in the formula) has to be adapted as follows to 
access this data: 

?? The first digits, before the hyphen, correspond to the line number of a financial item
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?? A hyphen 

?? The characters following the hyphen depend on the information you wish to display 
with reference to the peer group. Please, refer to the table below (it has to be typed in 
capital letters): 

 

Variable to display Code Example 

Number of banks in the group PN 2025-PN 

Minimum PI 2025-PI 

Decile 1 PD1 2025-PD1 

Decile 2 PD2 2025-PD2 

Quartile 1 PQ1 2025-PQ1 

Decile 3 PD3 2025-PD3 

Decile 4 PD4 2025-PD4 

Median PM 2025-PM 

Decile 6 PD6 2025-PD6 

Decile 7 PD7 2025-PD7 

Quartile 3 PQ3 2025-PQ3 

Decile 8 PD8 2025-PD8 

Decile 9 PD9 2025-PD9 

Maximum PX 2025-PX 

Mean PA 2025-PA 

StdDev PS 2025-PS 

Position Quartile PQ 2025-PQ 

Position Decile PD 2025-PD 

 

Important Note :  

 

In the case where an Own Peer Group has been assigned to the bank displayed, the own 
peer group will be displayed instead of the standard peer group. 

 

Example: 

The following formula displays the median of the Peer Group of BBL for Total 
Assets in 1998 expressed in billions of BEF :  

=BvD.GetCdData32 (“BANKSCOPE”,”10028”,”BEF”,”9”,”1998”,”2025-PM”) 



 

 

 

 
Figure 73 

 

 
Figure 74 

 

 

Figure 75 

 
 
 

 
Figure 76 
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12.2. Bureau van Dijk Add-In For Access 

The purpose of this Add-In is to easily create forms combining BankScope data 
with user input and/or internal Access databases. This Add-in uses a wizard approach 
which consists of several steps requiring the user’s input. When completed, the 
specified form will be created automatically.  

Once the form is designed, additional information can be typed in. Not only text, 
but also figures, hyperlinks and even files : all information referring to the bank under 
study can be directly stored in your Access Database. 

As explained farther in this Chapter, this add- in creates a live link between 
Microsoft Access and the CD-ROM : whenever a company is displayed in a form, all its 
financials will be extracted directly from the CD-ROM. Except for the identification 
numbers of the companies, no other BankScope information is stored in Access. 

 

12.2.1. INSTALLING THE ADD-IN FOR ACCESS 

1. Start Access and click on ‘File’ then on ‘New’ to create a new database. 

2. From the database container, choose ‘Tools’ - ‘Add-In’. Select the option ‘Add-In 
Manager’. The dialog box shown in Figure 74 will be displayed.  

3. Click  and open the File ‘BvDADDIN.MDA’ located in the folder where 
the software has been installed (example :C:\SCOPE32\ for BankScope). When this 
is done, close the Add-in Manager window (see Figure 75). 

4. Click on ‘Tools’ and ‘Add-Ins’. The sub menu will now show a ‘Bureau van Dijk 
ADD-IN’ item (see Figure 76). 

 

NOTE:  The Bureau van Dijk Add-In will be available the next time you 
open this Access Database. Whenever you want to create a new 
database template, you will have to launch the Add-in again (see  
Creating an Access Form combining Corporate Data and User Data). 



 

 

 

 
Figure 77 
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12.2.2. CREATING AN ACCESS FORM COMBINING CORPORATE DATA AND USER DATA 

1. Once the Add-in is installed, choose Tools-Add-Ins-Bureau van Dijk Add-In. The 
dialog box in Figure 77 will be displayed. 

2. Click ‘Select a Bureau van Dijk Database’. The dialog box displayed in Figure 78 
pops up. All BvD CD-ROMs installed on your machine will be available in the drop-
down menu. Select “BankScope” and click ‘OK’. 

Click the ‘Select the variable(s)’ button. The dialog box illustrated in  

3.  Figure 79 will appear, allowing you to select the items you want to display in your 
Access Database. Use the drop-down to select a previously saved set of variables or 
click ‘New Set’ to create a new set then click ‘Close’. 

Click ‘Select the Period(s)’. The Periods to be displayed in Access will be shown. If you want to 
modify these, click the ‘Change’ button and then ‘Close’ (see Figure 80). 

4. Click ‘Select the companies’ to choose the banks that you want to include in your 
database. This displays the BvD Add-in screen that allows you to select banks from 
the BankScope database as if you were using the BankScope search programme (see 
Figure 81). 

5. Click . 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 82 
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6. In the appearing screen, check the ‘define your own fields to add on the form’ tick 
box to display the table (see Figure 82) in which you will have to type the name and 
the type of  the fields you want to add to your database.  

The following type of  fields are available from the type drop-down. 
 
?? Text  

The text typed in by the user can include up to 255 characters.  
 
?? Memo 

These fields can include a lot of text and are ideal for typing in comments. 
 
?? Currency 

Only values can be typed in in these fields. These figures will be displayed using the 
currency settings of your system. 
 
?? OLE  

These fields allow you to link or insert OLE Documents. This means that you can store in 
your database all documents related to the corporation under study, whatever CD-ROM 
they come from 
 
?? HyperLinks 

You can type WebSite addresses in these fields. Clicking on them will open your Browser 
at the webpage specified in the field. 
 

NOTE: The Add-In will add one table to you database called “BankScopeIds”. Note 
that the properties of the fields created can be changed manually at a later 
stage. Please refer to the Access User’s Manual for further explanations. 

 

If you want to introduce user fields that may vary from year to year, you can choose 
among the following field types from the type drop-down list: 

?? ‘Text – Yearly’ 
 
?? ‘Number– Yearly’ 

 
?? ‘Currency – Yearly’  

 
?? ‘Date – Yearly’. 

 

Once all user-defined fields have been specified, click . 



 

 

 

 
Figure 83 

 

 

 

 

 
Figure 84 
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7. Specify the items (selected from the CD-ROM or created by the user) which have to 
be displayed in the header of the form. Just highlight the fields and click  or click 

 to select all the items (or  to deselect all of them). They will be moved to the 
‘Header fields’ box (see Figure 83). Click . 

8. Select the ‘Style’ in which your form will be built and click . 

9. Give a name to your form and click ‘Include a Bureau van Dijk Toolbar’ if you want 
the Add-In to create a toolbar with the following buttons : 

 

allows you to select the banks to be displayed on the 
form according to available search criteria (By name, 
by geographic region, by financials..) after the form 
has been created; 

 
allows the user to print and to preview the form for the 
displayed Companies ; 

 
allows the user to edit the form and change its design 
(location, font, size, colour etc … of the objects).  

  

10. Click ‘Finish’ to generate the form. 

NOTE:  The Add-In will automatically add two objects to your database: 

?? A table containing the index numbers called BankScopeIds. 

?? A query displaying the variables selected for the banks and the 
periods named BankScopeData.



 

 

 

 

 

 

 

 

Click to select
companies

Print Preview

Al lows you to
change the design

o f  the  fo rm

ISO CURRENCY code
(e.g. USD, DEM…):

you can type
another  code to
update the form

Unit  code:
 -1 Original unit
 of  the s ta tement
 3 Thousands
 6 Mill ions
 9 Billions Click to display the

other selected
banks

Data typed in f ields
designed by the user
wil l  automatical ly be

saved in the table
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12.2.3. EXAMPLE OF FORM CREATED WITH THE ADD-IN 

An example of form generated with the Add-In is illustrated in Figure 85. The 
toolbar will automatically appear along with the form. When a form created with Add-In is 
edited, all the textboxes displaying data coming from the CD-ROM contain a formula which 
is recalculated by Access whenever one of the parameters in the formula changes. 

12.2.4. THE ACCESS ADD-IN FORMULA STRUCTURE 

The Add-in formula in Access has the same structure as the Add-in formula in Excel, 
except, of course, that all the parameters refer to the controls on the form and not to cells on a 
worksheet. Please refer to “Section 12.1.3 The Excel Add-In Formula” for more details on 
this subject. 



 

 

 

 

 

 

 

 

 

 

Figure 86 
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12.3. The “Bank Credit Report Presentation” Software  

The Bank Credit Report, available as an optional subscription, allows you to 
create an instant custom credit sheet for any bank in BankScope.  

 

12.3.1. DISPLAYING THE DEFAULT BANK CREDIT REPORT 

After selecting a bank or a group of banks, click the  button at the top of 
the screen. The bank will then appear in a default template, as shown in Figure 86.  

12.3.2. LOADING ANOTHER TEMPLATE 

You can load different types of templates. To do so, click  and choose 
Load Another Template. Select the desired template and click ‘OK’. By default, you 
have the choice between two pre-defined templates: Standard I and Standard II. If other 
templates have been created and saved in the user folder, they will also appear in this 
category. If they were saved in another one, choose the option ‘Others (not in the user 
dir.)’ and browse for ".bcr" files. 

12.3.3. CREATING A NEW TEMPLATE 

You can create as many templates as you wish by clicking  and choosing 
Make a New Template. A blank sheet will be displayed next to the 13 icons which can 
be used to create the objects and to position them anywhere on the page. 
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1 2 . 3 . 3 . 1 .  P O S I T IO N I N G  A N  O B J E C T  

First click the icon representing the desired object and then click the sheet where 
the object has to be located. The object will have a default size, which can be modified 
later. 

 

 Bank Name 

 Identifiers 

 Used Peer Group 

 Bank ratings 

 Yearly statement 

 Reuters news 

 Shareholders 

 Banking Subsidiaries 

 Graphical illustrations 

 Peer Report 

 Peer Report illustration 

 Free Text  

 Own Logo 



 

 

 
 

 
Figure 87 
 

 
 
 

 
Figure 88 

 
 

 
 
 
 

 
Figure 89 

  

Figure 90 
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1 2 . 3 . 3 . 2 .  S E L E C T I N G ,  M O V I N G  A N D  S I Z I N G  O B J E C T S  

 Click on the object or its border. A border with handles (anchors) will appear around 
the object to indicate its selection as shown in Figure 87. You can move the object by 
holding the left button pressed and moving the mouse on the sheet. Slide the handles to size 
the object free-hand or use the “Size” option from the BCR-Layout menu. If you select the 
Size option, a dialog box pops up so that you can specify the horizontal and vertical lines. 

1 2 . 3 . 3 . 3 .  E D I T I N G  T H E  C O N T E N T  A N D  T H E  L A Y O U T  O F  A N  O B J E C T  

First select the object you want to edit as described above. To modify this object 
(format, colour, variables displayed, years displayed etc...), click the right-mouse 
button. A context menu will appear showing all options specific to this object.  

For example, a right-click on the “Yearly Statement” object will display the menu illustrated 
in Figure 88. If the option “Stat. Item Selection” is chosen, it is then possible to select the 
lines to be displayed. 

1 2 . 3 . 3 . 4 .  A L I G N I N G ,  S P A C I N G  A N D  R E S I Z I N G  S E V E R A L  O B J E C T S 

You can select more than one object by pressing the Shift key ?  of your 
keyboard and clicking all the objects. A dotted border with handles will appear around 
the objects to indicate that they are selected (see Figure 90). 

Drag the handles to resize the objects or select Layout-Size from the BCR menu. 
If you select the Size menu, a dialog box pops up to let you specify the horizontal and 
vertical sizes. You can drag the object on the sheet by holding down the left button.  

1 2 . 3 . 3 . 5 .  C H A N G I N G  T H E  C O L O U R O F  O B J E C T S  

You can define a background colour for all the objects in the BCR. To do so, 
right-click on the object and choose Background Colour. To edit the background colour 
of the page, choose the Options-Extra Page Setup from the BCR menu (see Figure 89). 
In this case, if you tick the Apply changes to entire document checkbox, the new colours 
will become the default colours for all new templates. 
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Further to resizing several objects at a time, you can also use the icons to the 
right of your screen to modify the alignment, the size and the spacing among several 
objects. Find below a brief description of their functions: 

 

I C O N S  F O R  A L I G N I N G ,  S I Z I N G  A N D  S P A C I N G  O B J E C T S  

 

Alignment Alignment Shrinking to the Smallest Growing to the Largest  Evenly Spacing 

 

  Left Side  Horizontal  Vertical Size   Horizontal Size   Across 

 

  Right Side   Vertical   Horizontal Size    Vertical Size   Down 

  

  Top 

 

  Bottom 

12.3.4. SAVING A NEW TEMPLATE 

When you have finished designing your new template, click  and choose 
Save as. This displays a window in which you can type a name for your new template. 
The file will be saved in your user folder with a ".bcr" extension. 

12.3.5. EDITING AN EXISTING TEMPLATE 

To modify a template, display it on the screen. Click  and choose Edit the 
displayed template. The 13 icons described above will be displayed on the screen. These 
will allow you to place on the sheet any information available in BankScope. When you 
have finished editing the template, click  and choose Save the template. 

 

NOTE:  the Standard I and Standard II templates may not be modified. 
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12.3.6. SETTING A TEMPLATE AS DEFAULT 

Once you have designed and saved a template, click  and choose Specify 
a current template: the template you select will be displayed whenever you open a BCR 
window. 

NOTE:  You can switch to another template at any time by clicking  and 
choosing Load another template. 

12.3.7. MODIFYING THE LAYOUT OF THE TEMPLATE 

You can change the general layout of the BCR by clicking  and choosing 
one of the proposed layouts. 

12.3.8. PEER GROUP REPORT AND ILLUSTRATION 

If you have used Peer objects in your template, the  button becomes 
available and offers the following options: 

Currency allows you to display the Peer Report and the Peer Illustration in 
the currency of your choice ; 

Variables allows you to select the variables which will be available in any 
Peer Report or Peer Illustration Report ; 

The Standard Peer Group displays the values of the Standard Peer Group for the selected 
variables; 

Your current Peer Group displays the values of your Current Own Peer Group for the 
selected variables; 

Another Peer Group allows you to select any Peer Group made up of a previously 
saved set of banks (*.SET). 

12.3.9.EXPORTING THE BCR 

Thanks to the File-export command, you will have the possibility to export the 
BCR in RTF Format. This format can be read by the most popular word processing 
packages (Microsoft Word, WordPerfect etc...) 

For more details on the subject, please refer to Chapter 14. 



 

 

 

 
Figure 91 

 

 
Figure 92 

 

 
Figure 93 
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12.4.Bureau van Dijk Scoring Wizard For Access 

The purpose of this wizard is to allow users to design in a few seconds a scoring 
model calculating a Final Score based on three type of scores : 

A Quantitative Score based on an evaluation of selected financials coming from 
BankScope. The way the financials have to be evaluated will be specified by the user during 
the wizard process. The score of all financial variables will be weighted to compute a 
Quantitative Score. 

A Qualitative Score based on variables defined by the user. The scores will be 
assigned by the user and weighted to compute a Qualitative Score. 

A Country Score also based on variables specified by the user. The scores will be 
assigned by country and those scores will be weighted to compute a Country Score.   

The Final Score is calculated by weightings the Quantitative, Qualitative and 
Country Scores. 

When the wizard is completed, the specified scoring model will be created 
automatically (see Figure 91): it will then be possible to apply it to any statement of 
BankScope.  

12.4.1. CREATING A SCORING MODEL WITH THE WIZARD 

1. Start Access and click on ‘File’ then on ‘New’ to create a new database. 

2. From the database container, choose ‘Tools’ - ‘Add-In’. Select the option ‘Add-In 
Manager’.  

3. Click  and open the File ‘BvDScore.MDA’ located in the folder where 
the software has been installed (example :C:\SCOPE32\ for BankScope). When this 
is done, close the Add-in Manager window (see Figure 92). 

4. Click on ‘Tools’ and ‘Add-Ins’. The sub menu will now show a ‘Bureau van Dijk 
Scoring Wizard’ item (see Figure 93). 

 

NOTE:  The Bureau van Dijk scoring wizard add- in will be available the next 
time you open this Access Database.  

 



 

 

 
Figure 94 

 

 

Figure 95 

 
Figure 96 
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5. Once the Wizard is installed, click on ‘Tools’ then on ‘Add-Ins’ then ‘Bureau van 
Dijk Scoring Wizard’. The dialog box illustrated in Figure 94 will be displayed. 

6. Click ‘Select a Bureau van Dijk Database’. The dialog box in Figure 95 will come on 
the screen. All BvD CD-ROMs installed on your machine will be available in the 
drop-down menu. Select BankScope and click ‘OK’. 

7. Click ‘Select the Period(s)’. The Periods to be displayed in Access will be shown. If 
you want to modify these, click the ‘Change’ button and then ‘Close’. 

8. Select the units and the currency in the drop-down lists then click . 

9. Click the appropriate check boxes to specify what sections have to be created in the 
model (e.g Quantitative, Qualitative and/or country sections). Specify a weight for 
each of these sections (used to compute the final score) and click ‘Selection of the 
Variables’ to specify what variables have to be included in each section (refer to 
Figure 96). 

 

NOTE:  The Wizard will add two tables to your Access database :  

?? the name of the first table is “BankScopeIds” and will contain the 
user data relating to the banks which have been scored. 

?? the name of the second table will be “CountryBankScope” and 
will contain all scores relating to the countries. 

 

10. The variables can be evaluated according to three different methods : 

- A User Defined Function. This enables the user to assign a score when a 
variable reaches a specified benchmark. Simply specify the Operator (>, < , 
>=, <= or =), the benchmark and the score to be assigned if that condition is 
satisfied. The number of conditions is not limited (see Figure 97). 

Note : you can specify a score if the value is not available or if the value 
doesn’t match any created condition by ticking the appropriate check-box. at 
the bottom of the screen. 



 

 

 
Figure 97 

 

 
Figure 98 

 

 
Figure 99 
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- The position of the variable in the quartiles of the peer group. In this case, the 
user can specify the score to be assigned depending on the position of the 
variable within the quartiles of the peer group. 

- The position of the variable in the deciles of the peer group. In this case, the 
user can specify the score to be assigned depending on the position of the 
variable within the deciles of the peer group. 

11. Specify the weights for each qualitative variable in the dialog box illustrated in 

Figure 98. Click . 

12. Specify the weights for each country variable in the dialog box illustrated in Figure 

99. Click . 

13. Give a name to your Scoring Model as shown in Figure 100. 



 

 

 

 

 

 

 

 
Figure 100 
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The various check boxes below the “Your template’s name” text area allow you 
to have the Add-In create a ‘Bureau van Dijk Toolbar’ and to choose what buttons 
should be available on it.  

 

 
A  button will be allow you to select the 
companies to be scored according to any available search 
criteria (By name, by geographic region, by financials..); 

 
A  button will allow you to open the 
Countries table with the country scores which have been 
input by the user ; 

 The  icons will let the user print and preview the 
model for the displayed Companies ; 

 
Thanks to the  icon, the user will be able to edit the 
scoring model and change its design (location, font, size, 
colour etc … of the objects).  

 



 

 

 

 

 

 

 

 

 

 

 

 
Figure 101 
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13.  INTERNET ACCESS FOR UPDATED STATEMENTS AND 
REUTERS NEWS 

13.1. Accessing BankScope data through the Internet 

BankScope CD-ROM users now have the possibility to extract data directly 
from the Bureau van Dijk Web Site via the Internet. This will allow you to access the 
updated database of BankScope at any time between two releases of the CD-Rom.  

From the main screen, select 'Options' - 'Access Mode'. The dialog box 
illustrated in Figure 101 will be displayed. 

 

In order to extract data from our Internet site, click on the 'Internet' radio-button. 
The type of online connection must then be set to one of the following: 

 

?? If you access the Internet via your local area network, select the 'No Dialup 
(Local Network)' from the Online drop-down menu. In this case, you have to 
make sure that the port 1001 is in free access. Please consult your IT 
department to confirm this. 

 

?? If you access Internet via a modem, please select the appropriate connection 
to your Internet provider. This connection must establish a connection to 
your Internet Provider. Note that the 'Dial-up Networking' module must be 
installed from Windows. If it is not installed, open the 'Control Panel' and 
click on the 'Add/Remove Programs' Icon. Go to 'Windows Setup' then to 
'Communications'. Click on 'Details' and select the 'Dial-Up Networking 
Icon'. For more information, please refer to the Windows Manuals. 

 

Click then on  to validate your selection. BankScope will restart and 
use the data directly from the Web instead of those found on the CD-ROM. It must be 
stressed that this is not a download of information but a direct access to an updated 
database located on our server. 

 

Important note: 

 

A browser version of BankScope is also available at www.bvdep.com. Please 
contact your local account manager for more information. 



 

 

 

 

 

 

 

 

 

 

 
Figure 102 
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14.  SAVING, LOADING AND EXPORTING BANK SETS/PRINTING 

14.1. Saving and loading a bank set 

As mentioned in chapter 6 above, search strategies and bank set files can be saved. To 
do so, use the corresponding options of the “File” menu (Figure 102). 

14.1.1.SEARCH STRATEGIES 

The extension of the file is [*.srh]. In this case, you save the various search 
criteria that you have defined. When you open a previously saved search strategy, the 
result may differ from month to month as bank accounts are updated. 

14.1.2.BANK SET FILES 

As indicated in section 6.6., three types of bank set files can be created: 

 

Type [*.set] :  the file includes all financial data relating to the saved banks. This type 
of file is proposed by default when saving a bank set. Such files will be 
used for conducting Peer Group and Statistical Analyses (See Chapter 9 
and 10). 

 

Type [*.bvd] :  the file includes only the index numbers of the selected banks. Group of 
banks must be saved using this extension for use with BankScope’s 
Add-In feature (See Chapter 12). 

 

Type [*.pgf]:  this file includes a an own peer group which can be assigned to one or 
several subject banks (See Chapter 9). 

NOTE: 

a) In BankScope, several other types of files are automatically saved without 
the user making any manipulation. This concerns the formats, the layouts, 
the customised accounts, the statements updated or modified by the user, the 
bank set files where statements have been excluded from the peer and 
statistical analysis, the set of variables for the graphical illustrations, the 
peer group comparisons and the statistical analysis; 

The transfer of lists and reports to other software implies the creation of 
corresponding files, structured according to a format specific to the software 
programme in which the data will be used. This is explained below in 
section 14.3. 
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14.2. Loading and Saving files 

Search strategies and bank set files can be saved and retrieved by using the two 
corresponding options of the file menu. 

14.3. Exporting files 

It is possible to transfer to various software programmes (spreadsheet, word-
processing or database software): 

 

- Lists of banks; 

- Reports; 

- Comparison tables and group reports (of the statistical analysis). 

- Bank Credit Reports 

 

The table below indicates for each software the types of transfers that are possible: 

 

 

Software List Report Comparison 
Table or 
Group 
Reports 

BCR Type of file 

Excel X X X  [*.xls] 

DBase X - X  [*.dbf] 

Lotus 1-2-3 X X X  [*.wk1] 

Sylk   X  [*.slk] 

Multiplan X X X  [*.slk] 

DIF X - -  [*.dif] 

Rich Text Format (Word for 
Windows…) 

X X - X [*.rtf] 

ASCII X - X  [*.txt] 

ASCII [Delimited] X X   [*.asc] 

 



 

 

 

 

 

 

 

 

 

 

 
Figure 103 
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14.4.Formatted export 

It is also possible to design the layout of the file you want to export by clicking 
on ‘File’ then ‘Export to' and choosing ‘Formatted Export to’. This will display a dialog 
box (Figure 103) allowing you to specify the variables to be transferred, the layout of 
the table to be created, the years and the currency. 

14.5. Printing 

The printing option can be accessed from: 

 

- the  icon in the top left corner of the screen; 

- the “Print” option from the “File” menu. 

 

Several parameters can be specified: 

 

- the print quality (600,300,150 or 75 dpi depending on the printer); 

- a fast printing option which will delete the borders and lines of tables that are 
time consuming to print; 

 

Note that by clicking on the “Print to file” check box, data will be transferred 
onto a disk so that it can be printed from another workstation. 

14.5.1.PRINTING A LIST OF BANKS 

When the list is displayed, just click on the  icon or on the “Print” option 
from the “File” menu. If banks are marked in the list, you can choose to print the  
marked (or the unmarked) ones as well as the whole list. 

14.5.2. PRINTING BANK REPORTS  

When one or several banks have been selected and a report is displayed, it can 
be printed by clicking on  or on the “Print” option from the “File” menu. 

You can also choose to print the marked (or unmarked) reports or both, as for 
the list. 

If you click on the “Several companies per page report” check-box, the page 
break will be suppressed after each report. This feature is very useful if you print just a 
few lines (e.g. a Profile format or a customised account). 

Also note that you can print just a selection from a Report: click on the first line, 
hold down the 'Shift' key (? ) of your keyboard and click on the last line. Then choose 
the "Print" option from the "File" menu and tick the "Selection" radio-button. 
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14.5.3. PRINT PREVIEW 

This option of the “File” menu enables you to see exactly what will be printed. 

14.5.4. PRINTING COMPARISON TABLES AND GROUP REPORTS OF THE STATISTICAL ANALYSIS 

When a comparison table or a group report of the statistical analysis is displayed on the 
screen, click on  or choose File-Print. 

14.6. Deleting Files 

It is possible to delete customised formats, formats of lists, layouts, sets of 
variables defined for the illustrations, for the comparison tables or for group reports in 
the statistical analysis by clicking on  in the dialog boxes which are of type 
“Format” or “Set of variables”, when the name of the file is displayed in the drop-down 
menu. 

The files referring to the search strategies [*.srh] or banks [*.bvd or *.set or 
*.pgf] can be deleted by deleting the file from the folder where they are stored on your 
hard-disk (by default, SCOPE32\USER). The same applies to the files created for 
transfer to other software programmes or for printing. 
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15.  OPTIONS AND FILE MENUS 

15.1. The “Options” menu 

This menu (illustrated in Figure 104) enables you to: 
 

a) create a new format and set as current format one of the existing formats (including 
the standard format) for: 

 

- the list of banks; 

- the report of banks; 

- the layout; 

- the variables used in the illustrations IV and V associated with a bank 
report; 

- the variables included in the peer comparisons and the peer groups 
in the statistical analysis. 

 

The selection of one of these options will display a menu: 
 

- New Format  

- Current Format 
 

By clicking on the first line, you obtain the dialog box enabling you to create the 
corresponding format (described respectively in chapter 5, 4, 9 and 10) 

The “current format” button will display the list of existing formats, including 
the standard format and enables you to set one of these as current.  

 

b) specify a sorting criterion for the list; 

 

c) create: 

- customised formats; 

- user defined variables. 

 

d) set the currency as well as the units used in the peer and statistical analysis; 



 

 

 

 

 

 
Figure 105 
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e) modify exchange rates. Choosing this command will display the dialog box 
illustrated in Figure 105. First select the base country and the destination country of 
the currencies for which you want to input a rate. Click just beside the proposed 
exchange rate and type in your own value. Clicking on  will allow you to 
insert a closing date that is not present in the table.  

Ticking the “Fixed rate - apply to all years” check-box will set, for all years, the 
exchange rate you typed in the box. 



 

 

 

Figure 107 

 

 

 

 

 
Figure 108 
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15.2. The “File” menu 

This menu (illustrated in Figure 106), which has already been mentioned often 
in this manual, enables you to: 

 

a) save or retrieve a search strategy or a bank set file (cf. sections 14.1 and 14.2 
above); 

b) merge two bank set files. Clicking on this option will display Figure 107. 

Highlight the bank set to be merged and click on . Use the 
same procedure for the second bank set as well as for the output bank set; 

c) Save the peer group: see section 6.7. 

d) Associate companies to existing peer groups: this menu allows you to 
associate the banks selected after a search to a saved own peer group. It 
displays the menu in Figure 108: to define a link, select both the bank and 
the peer group, then click the Associate button. The check box next to the 
bank name will be ticked. 

e) Save image file: this command allows you to save a graphical illustration 
displayed on the screen with a *.bmp extension. 

f) export a list of one or several bank reports to another software (see section 
14.3); 

g) Send to: this command allows you to automatically generate an e-mail 
message with an *.rtf attachment containing the list or the report that was 
displayed on the screen when you selected the command. 

h) print a list or a report or display a print preview (see section 14.4); 

i) set up the printer; 

j) access the own data module (see Chapter 11); 

k) quit the application. 

 



 

 

 
Figure 109 

 

 

 

 
Figure 110 
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16.  TEXTUAL INFORMATION MODULE 

16.1. Reuters News  

Bankscope contains two years of Reuters News taken from the Textline 
Corporate Database produced by Reuters and relates to Industry Code I81 (Banks and 
Financial Institutions). This represents about 65,000 news items. An internet connection 
to a server located in Brussels, hosting the news that has appeared since the last 
BankScope was produced, is offered to users equipped with an internet connection  (see 
Chapter 13). 

 

16.1.1. ACCESSING THE NEWS ATTACHED TO A STATEMENT 

Reuters news can be accessed, when a Report is displayed, by clicking  and 
on the “News section” option. The list of News items attached to the statement appears 
on the screen (Figure 109). Clicking  will unfold the corresponding article. 

 

A Click on   will display the list of News items for the next (or former) 
selected bank. 

 

16.1.2.FULL TEXT SEARCH 

You can start a full text search in the Reuters Texline database by clicking on 
 in the search screen. A dialog box will be displayed as illustrated in Figure 

110. Type in the descriptors you are searching for in the three search fields. Click on the 
corresponding check-boxes to restrict your search to the text and/or the headlines. The 
search can also be restricted to : 

 

  a saved set of banks (see Chapter 14); 

 a period of time for your search. Note that any date must be 
entered by typing six digits in the sequence "day/month/year".  

 For instance, March 2, 1999 must be typed: 02/03/1999. 

 the banks which are currently available on BankScope; 

 Companies quoted in the Reuters News archived on the CD, 
whether they are listed or not on BankScope (a Reuters story of 
the Industry Code I 81 may very well refer to non-banking 
companies or to small banks not listed on BankScope). 
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When your search has been completely defined, click on  to select the articles 
that meet your criteria and on    to display the corresponding list of articles. 
Once the list is displayed, you can unfold the content of an article by clicking on  . 

 

1 6 . 1 . 2 . 1 . U S I N G  B O O L E A N  O P E R A T O R S  I N  T H E  F U L L  T E X T  S E A R C H 

In each of the three search fields, you can enter one descriptor or a sequence of 
descriptors. To make a Boolean link just type, between two spaces, in normal lowercase 
characters, the word and, or or but not. When the descriptors are entered in sequence, 
with no operator between them, they will be treated in the search as strictly adjacent. 

You can specify a proximity by typing the operator s/n, where “n” specifies that 
the second descriptor must be found between 1 and n words after the first descriptor. 

For instance, the texts with the expression "capital adequacy ratio" will not be found if 
you type 

 

capital ratio 

but will be found if you type 

capital s/2 ratio 

 

If you look for the texts containing the notion of such a ratio, be more precise and type 
the following expression: 

 

risk asset ratio or capital s/2 ratio or cooke ratio or basle ratio 

 

You can use up to 80 characters to enter such expressions in any of the three search 
fields. 

 

1 6 . 1 . 2 . 2 . T R U N C A T I O N  I N  T H E  F U L L  T E X T  S E A R C H  

Use the sign ! to specify a truncation. For instance, if you want to enter the 
concept of "financial difficulties", enter something like 

 

bankrupt! or heavy loss! or financ! difficult  
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1 6 . 1 . 2 . 3 . P R I O R I T I E S  A M O N G S T  T H E  B O O L E A N  O P E R A T O R S 

If you do not use brackets, the operators will act in the following order of priority: 

 

OR 

s/n 

BUT NOT s/n 

AND 

BUT NOT 

 

For instance, the expression 

 

A or B s/3 C or D 

 

will be interpreted as: 

 

 (A or B) s/3 (C or D) 

 

and not as 

 

(A or B s/3 C) or D 

 

The expression: 

 

A or B s/3 C and D 

 

will be interpreted as 

 

((A or B) s/3 C) and D 

 

If uncertain, just make use of brackets ! 



 

 

 

 

 

 

 

 

 

 

 
Figure 111 
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16.2. Capital Intelligence Reports 

16.2.1. SERVICE AND COVERAGE 

Capital Intelligence provides a service of reports and ratings covering over 400 
major banks located in the Gulf/Mediterranean, Asia/Pacific regions as well as 
Central/Eastern Europe and South Africa. 

Bank Reports are detailed studies of individual institutions based on extensive 
financial analyses and meetings with the subject bank and others in the banking 
environment. Topics include shareholders, management, history and market 
background, operations and strategy as well as full financial evaluation. 

Rating Reports are shorter reports of individual institutions giving key data, CI 
ratings, strengths and weaknesses, summary financial analysis and objective assessment 
of the subject institution. 

Country Banking Reports are annual evaluations of each country’s banking and 
financial markets consisting of three separate sections: the Banking Supervision, the 
Accounting and Disclosure Standards and the National Banking Environment. 
 

16.2.2. SUBSCRIPTION  

There are two ways to subscribe to Capital Intelligence Reports on BankScope: 

 

?? you can subscribe annually for access to regional packages (Gulf/Mediterranean, 
Asia / Pacific, Central/Eastern Europe, South Africa or all); 

?? you can access Reports by purchasing from Bureau van Dijk a floppy disk 
containing a number of credits (called a credit disk). Inserting the credit disk will 
unlock the access to the information available for the next twelve months. The 
number of credits necessary to access the information will be deducted from the 
floppy disk: 

- 1 credit will buy an upgrade from a Rating Report to a Bank 
Report;  

- 2 credits will buy a Rating Bank Report; 

- 3 credits will buy one Bank Report.. 



 

 

 
 
 
 
 
 
 
 
 
 

 
 

Figure 112 
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16.2.3. ACCESSING THE CAPITAL INTELLIGENCE MODULE 

Click on  then on  and select the “Capital Intelligence 
Ratings & Reports” from the yellow menu top left of the screen (Figure 111). A menu 
offers you the following options: 

 

List of Rated Banks displays a list of banks rated by Capital Intelligence, 
sorted by country. The Foreign Currency Long Term 
rating, Foreign Currency Short Term rating, Domestic 
Strength, Support as well as the date of these ratings are 
listed; 

Revised Ratings  displays the list of banks the ratings of which have been 
revised since the last update of BankScope or since a 
given date; 

Access to Bank Reports displays a dialog box enabling you to select one or more 
banks from the index of banks rated by CI (Figure 112). 
This dialog box presents: 

?? the index of banks in the first column; 

?? the country code in the second column; 

?? the code for the type of Report in the third column : 

- BR  Bank Reports 

- BM  Bank Memorandum 

- RR Rating Report 

?? the fourth column contains the date of the report; 

?? an “M” in the fifth columns indicates that a Bank 
Memorandum is also available; 

 When the Subject Bank or Banks have been selected, click 
on   or  depending on the type of 
report you want to access. You will be asked to insert a 
credit disk if your subscription doesn’t allow you to access 
the selected report; 

 The selected Reports will be displayed in Microsoft 
WordViewer?  (or in Microsoft Word? ). Note that the 
corresponding word files will be copied in your User 
folder, in the CI sub-folder.  
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Access to Country Reports displays a dialog box that enables you to select the country 
under study. Once the country is selected, you will be 
asked to insert a credit disk if your subscription doesn’t 
allow you to access the selected Country Report. 

 The selected Reports will be displayed in Microsoft 
WordViewer?  (or in Microsoft Word? ). Note that the 
corresponding word files will be copied in your User 
folder, in the CI sub-folder.  

Production Schedule displays the production schedule of Capital Intelligence 
Reports. The date of the current issue is given together 
with the date of the next release; 

Rating Definitions displays the definition of the ratings used by Capital 
Intelligence; 
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16.3.1 The Economist Intelligence Unit Country Risk Service 

16.3.1.SERVICE AND COVERAGE 

The Country Risk Service enables you to make informed and immediate 
decisions about a country’s economic creditworthiness in both the short term and 
medium term. This exclusive two-year forecasting service, assessing the solvency of 
104 indebted countries is now available on BankScope. Each individual Country Risk 
Report includes projections of GDP, the budget deficit, the country’s trade and current-
account balances, its financing requirements and its debt-service ratio. 

 

It contains : 

 

?? Credit Risk Rating- reflecting a country’s short-term trade risk, medium-term 
lending risk, and political and policy risk. 

 

?? The state of government finances- economic growth and domestic financial 
indicators (money supply, interest rates, inflation, exchange rates). 

 

?? External Finances- 2-year projections of the country’s external finances, including 
the current account, external borrowing and debt-servicing payments. 

 

?? International financial flows - foreign direct investment, bond issues, portfolio 
investment and commercial or official lending. 

 

?? Domestic financial markets- incisive analysis of the bond, money and stock 
markets. 

 

?? Portfolio pointers to investors - independent comment on the prospects for financial 
markets in these emerging markets. 

 

In addition, a Risk Ratings Review is published each quarter, providing a summary of 
the EIU’s ratings for 104 countries. Produced as a separate report of typically 28 pages, 
it includes a written analysis of each region, giving early warnings of potentially 
deteriorating or improving economies. All Reports will be displayed in Microsoft 
Viewer® (which is installed during the setup of BankScope) or Microsoft Word (if 
previously installed on your machine). 
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16.3.2.SUBSCRIPTION 

You can access reports by purchasing from Bureau van Dijk a floppy disk 
containing a number of credits (called a credit disk). Inserting the credit disk will unlock 
the access to the Country Risk Reports available for the next 12 months. The number of 
credits necessary to access the information will be deducted from the floppy disk : 

 

- 1 credit will buy a Country Risk Report.  

 

16.3.3.ACCESSING THE ECONOMIST INTELLIGENCE UNIT COUNTRY RISK SERVICE MODULE 

In order to access this new section, click on ‘Rating Services’ then on ‘The E.I.U 
Country Risk Service’. The following options will be displayed on the screen : 

 

- List of surveyed Countries provides a list of all countries covered along with 
the Overall Rating and the Overall Score. This 
section is free of charge. 

- Country Risk Report  allows you to access any report(s) available. The 
system will ask you to insert a ‘Credit Disk’ that 
can be ordered in any Bureau van Dijk office. One 
credit will be used to access a report and deducted 
from the Credit Diskette. 

The Reports selected will be displayed in Microsoft 
WordViewer?  (or in Microsoft Word? ). Note that 
the corresponding word files will be copied in your 
User folder, in the EIU sub-folder.  

- Risk Rating Review allows you to access the Risk Rating Review 
Report published quarterly. You will be requested 
to insert a Credit Diskette to access the information 
but no credits will be deducted. 

- Handbook On a monthly basis this section provides 
information about updated countries, the 
production schedule and an alert sheet. You will be 
requested to insert a Credit Diskette to access the 
information but no credits will be deducted. 

- Publishing Schedule displays the publishing schedule of each surveyed 
country. This option is free of charge. 

- Rating Definitions displays the definition of the ratings used by the 
Economist Intelligence Unit. 
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17.  HELP MENU 

The Help section can be activated by clicking on the ‘Help’ item from the menu bar. 
Clicking on this option will display a menu with the following options : 

 

What is new in BankScope ? This section features the innovations on BankScope for 
this release and preceeding ones. Any change in the 
FITCHRATINGS formats will also be indicated in this 
section. If you have any customised formats related to 
the amended FITCHRATINGS formats, please adapt 
them accordingly.  

 

Contents This option is an electronic version of the present 
manual. Clicking on any section displayed in green will 
unfold more detail. 

 

Coverage This section gives you the coverage of the cur rent update 
of BankScope. It includes several tables presenting : 

 

?? the number of statements broken down per last 
available year; 

?? the number of banks broken down per last available 
year; 

?? the number of banks broken down per Specialisation; 

?? the number of banks broken down per countries and 
regions; 

?? the number of statements broken down by 
consolidation code; 

?? the number of institutions with shareholding 
information; 

?? the number of institutions with subsidiary 
information. 

 

Glossary This section provides the user with a list of all necessary 
definitions concerning BankScope. Just type in a key 
word to access its definition. 

 

Ratio Definitions This gives you the definition of the 36 Standard Ratios 
associated to the Global Format. 



 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 113 
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Format Definitions This allows you to display the definitions of the data 
items used in the Global detailed, Global Summary, 
Spreadsheet or Raw Data Formats for any country. A 
click on this option displays a dialogue as illustrated in 
Figure 113. Select the format of interest and indicate the 
country model required in the 'FITCHRATINGS model' 
box (Albania is shown as first in the alphabetical model 
list). This option also enables you to display or print the 
logic you used in creating your own customised formats. 

 

BankScope and the Euro  This option displays a help page describing how Bureau 
van Dijk is treating the question of the Euro. 

 

BankScope and the year 2000  This option displays a help page describing how Bureau 
van Dijk is treating the question of the year 2000. 

 

Bureau van Dijk on the Web Choosing this menu will start your browser and connect 
you to the site of Bureau van Dijk. 

 

Bureau van Fitchratings Choosing this menu will start your browser and 
on the Web connect you to the site of Fitchratings. 

 

About  This option will display the update number of 
BankScope the drive letter of your CD-ROM, the 
Windows version currently installed as well as the 
resources of your system. 
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18.  MINIMUM REQUIREMENTS AND INSTALLATION 
PROCEDURE 

18.1.Minimum requirements 

?? processor Pentium 100 Mhz or higher; 

?? 64 Mb of RAM memory; 

?? 60 Mb of Hard-disk free space; 

?? Windows ‘95 (or later); 

?? quadruple speed CD-ROM drive or higher. 

18.2. Advisable configuration 

?? processor Pentium 200 Mhz or higher 

?? 128 Mb of RAM 

?? Windows '95 (or later) 

?? 20x speed CD-ROM 

18.3. Stand-alone and Network Installation procedure of BankScope  

1. Insert the BankScope CD-ROM into a local or a network CD-ROM drive. If it is a 
network installation, depending on your network operating system either share or 
mount the CD as a volume. 

2. From a workstation browse to the contents of the CD-ROM and run the 
SETUP.EXE: this will start the BankScope setup wizard and display the Welcome 
screen. 

Use the three buttons at the bottom of the wizard screen to navigate through the 
setup wizard.  

Click . 

3. The next screen prompts you for the password issued to you by Bureau van Dijk 

together with the CD-ROM. Type the password and click . 

4. In the Get Path screen, you have to type the drive and folder where the BankScope 
program and user files are to be installed. By default, they are installed in 
C:\SCOPE32 & C:\SCOPE32\USER. 

You can change this to a shared network drive, such as, for example: 
F:\APPS\SCOPE32. If you specify a non-already-existing folder in the path, it will 

be created for you. Click . 
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5. You will be prompted to install the Excel Add- in for BankScope. Click the check 

box if the Add-in is required. Click . 

 

6. A list of all the program groups existing on your PC will be displayed: choose the 
one in which you wish the BankScope icon to appear. The default group, BVD CD-
ROM’s will be created, if it does not already exist. 

7. The setup will start to copy the BankScope search software onto the network. 
Depending on the specification of the hardware being used, this process should 
only take a maximum of two or three minutes.  

8. Once the software installation is complete, you can choose to start BankScope or to 
simply exit the setup wizard. 

9. The icon to start BankScope is now available in the program group specified during 
the installation. If you wish to create a shortcut, it should be targeted to the 
SCOPE32.EXE file located in the folder where BankScope was installed. 

18.4. Specifying the location of the CD-ROM 

The path to the BankScope CD does not have to point to the root of a drive 
letter. You may specify the path to the CD by typing it in the “Specified UNC 
pathnames”  text box from the Access mode window (see Figure 114), which can be 
displayed by choosing Options-Access Mode. You can then type one of the following 
according to your case (or click on ): 

1)  Path to CD pointing to a folder: 

M:\BankScope  

2) Path to CD on a server: 

\\SERVER\ BankScope 

Where SERVER is the name of the fileserver, or CD tower with the 
BankScope CD-ROM 

And BankScope is the volume/share name of the CD.  



 

 

 

 
 

Figure 114 
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18.5.Accelerating the start-up of BankScope  

To accelerate the start-up of BankScope it is possible to scan a limited number 
of drive letters to find the BankScope CD. To do this, type the drive letters in the 
“Specified drives only”  text box from the Access mode window (see Figure 114), 
which can be displayed by choosing Options-Access Mode.  

Example: 

MNO 

Where MNO are the drive letters to scan for the BankScope CD. 

This is an alternative to specifying the location of the CD as described above.  

 

18.6. Setting up a workstation 

If you have installed BankScope on the network, you must run 
NETSETUP.EXE from the SCOPE32 folder on each local machine.  

This will allow you to additionally specify a local user directory for each 
BankScope user and will have two consequences: 

?? the users will have User folders different from the one located on the 
network 

?? a file, the “AI32.dll”, which is necessary for the Add-in to work, will be 
copied in the Windows folder. This means that if you do not run the 
NETSETUP.EXE, it is impossible to use the Add-in.  

 


